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“Often, expressive imagery is far from literal,
indeed the two may be polar opposites”

For a great many creative
people, photography is a
means of expression — a way
of converting emotions into

a physical representation of
who they are and what they
stand for. However, for some,
the act of photography itself
can present challenges most
of us would never stop to consider. On pl4 of the
magazine, we join a photographer on a mission

to highlight issues of accessibility in photography
and the small changes that could make the industry
a better environment for us all to work in.

Then, on p24, we dive into the core software
techniques for editing landscape images, covering
everything from colour treatment to lighting effects.
Create scenic shots that truly express the emotions
you experience when out in the field.

Often, expressive imagery is far from literal, indeed
the two may be polar opposites. Turn to p36 to learn
how to capture abstract photos that tell a story and
convey an idea rather than an object, getting your
work noticed by a wider audience in the process.

As creative people ourselves, your DP team never
likes to sit still for long, so we have two big new
features for you. On p96, be sure to check out our
exciting new Photo Kit Leaderboard — our real-time
guide to the best cameras, lenses and accessories
on the market. Meanwhile, on p112, we've introduced
a handy digital photography glossary for you. Never
be confused by photo jargon again!

| hope you enjoy the issue and, until next month,
| wish you a happy few weeks of photography,

wherever you are in the world.
o w——

Peter Fenech, Editor
peter.fenech@futurenet.com

GET IN TOUCH Ask a question, share your thoughts or showcase your photos...
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Our contributors

KIM
BUNERMANN
Our technique
editor, Kim, has
afondness for
creating abstract
photography, so
on p36, she shares
various techniques to transform
subjects with a mystical quality while
adding a layer of perception. Kim has
also written a tutorial on p62 on how
to add drama to your monochrome
portraits in Affinity Photo.

digitalcameraworld.com

e RAGHUVAMSH
CHAVALI

Canada-based
nature and wildlife
photographer
Raghuvamsh

’ has an interest
e - in discovering
new techniques and concepts in
photography and his pro advice forms
part of our Abstract feature. Turn to
p44 of the magazine to learn how to
combine movements abstractly with
the interlacing frames technique.

raghuvamsh.com

ISOBEL
GREENHALGH
The medium of
photography is
diverse, and so
for this month’s
Shoot Like A
Pro, we visited
Manchester-based Isobel, who
specialises in sessions for clients
with additional needs and raises
awareness of issues in the industry.
Turn to pl4 to see her vibrant style,
inspired by modern concept art.

isobelgcreative.co.uk

KUZMA
VOSTRIKOV

Kuzmaisa
multi-disciplinary
artist who doesn't
confine himself to
working solely with
photographs. His
artistic creations blend various art
forms to create conceptual frames in
a style that challenges and questions
the nature of art itself. Learn more
about Kuzma's career path, his
influences and essential gear on p70.

@kuzmacinema

© Mitchel Wu

KAV

DADFAR
Kavisa
seasoned travel
photographer
who has
contributed his
pro expertise to
our magazine on several occasions.
On p50, he demonstrates how

to capture photos that are not
crowded with people using a
technique that you might have tried
before... but for a different purpose.

dadfarphotography.com

NATALIA
ZMYSLOWSKA

Natalia often
travels around
the world to
capture its
diversity. This
month, she
visits the Scottish Owl Centre to
show you how to make the most
of the wildlife in your area. Find
her step-by-step shooting tutorial
on p56, focusing on the essential
settings for captivating shots.

theworldwithnat.com
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a pro studio P R&STUIO

A photographic studio was once the only way to have a
presence as a photographer. While the internet now offers
an alternative, for many wedding, portrait and commercial
photographers, a physical studio is still a vital part of their
operation. In this ebook, we cover the key factors of a
studio, such as gear outfitting and the challenges of using
a fixed location. With advice from pro photographers, you
will be able to build your own sustainable studio space.
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ACCESSORIES LIGHTING’ PRO WORKFLOW
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Affinity prizes

Every month, we team up with Photocrowd - the
world’s leading photography competition platform
— to offer you the chance to win an Affinity Photo
editing software licence (worth £60 for Mac or
Windows) and have your images printed in Digital
Photographer. Affinity Photo is a toolset engineered
for modern photography professionals. Whether
you're editing and retouching images or creating
full-blown multi-layered compositions, it has all the
power and performance you'll need. For a chance to
win, go to Photocrowd and discover our latest contest.
It's easy, free and fun — we love seeing your entries!

Visit: www.photocrowd.com/digitalphotographer
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IN FOCUS

DOES THIS CAMERA MAKE ND FILTERS
REDUNDANT? MEET THE OM-1 MARK I

Flagship firepower gets Al artillery: meet the OM System
OM-1Mark I, with some seriously clever new algorithmic tricks

Meet the OM System OM-1 Mark Il -

an all-purpose Al powerhouse that's

so smart, it might just replace your
neutral density and graduated filters.

At first glance, the differences between
this model and the original OM-1 might be
difficult to spot. But in short, what the Mark I
offers is more than double the buffer size for
burst shooting, an industry-best 8.5 stops
of in-body image stabilisation, improved
autofocus performance and what could be
the most exciting feature we've seen on
a flagship camera in ages — Al-based
graduated ND filters.

While the software and Al powering the
Mark Il have seen some welcome upgrades,
the core technology remains the same. The
body is identical apart from new rubberised
dials and at its heart is the same stacked
20.4MP sensor and quad-core TruePic X
processor. Of course, the other things people
loved about the OM-1, including 120fps burst
shooting and IP53-certified weather-sealing,
are also present in the new model.

Let's start with the Live GND filters. An
extension of the wizardry introduced with Live
ND filters, Live Graduated Neutral Density
filters provide an Al-powered, software-

based solution for shooting situations where
you may normally need an ND grad. The
autofocus gets a boost overall, being generally
stickier and offering human detection, but
the most significant improvement is when
it comes to birding. Here, the AF has been
beefed up when it comes to detecting fast-
moving birds in the first place, but also when
keeping track of them in flight. It can also
detect up to eight subjects and you can select
which one to focus on and keep track of.

The OM System OM-1 Mark Il is on sale now,
priced at £2,200 (body only).
explore.omsystem.com

Fujifilm updates its iconic premium compact with the X100VI

How do you follow up a camera

%‘h that had one of the most
‘L‘ passionate followings of recent
times? Fujifilm’s answer is the Fujifilm
X100VI, which replaces the now five-year-
old X100V. You probably won’t be able to
tell them apart by looks alone but why
change what is now an iconic design?

Those familiar with the previous
models should have no issue jumping
ship to the VI and feeling immediately at
home. However, this also means that the
X100VI’s lens isn’t seeing any innovations
— the X100VI keeps the same 23mm

(35mm full-frame equivalent) lens from
the previous model. The built-in four-stop
ND filter is also still present in the lens for
creative long exposures.

The biggest advancement is its new
40MP X-Trans 5 APS-C CMOS sensor,
which is also supported by six-stop
in-body image stabilisation as well as
Fujifilm’s latest X-Processor 5, powering
all the most recent autofocus tracking and
subject recognition algorithms, including
faces, eyes, birds, animals and vehicles.

The Fujifilm X100VI is available now,
costing £1,599. global.fujifilm.com/en

© OM System




IN FOCUS

Sigma expands its Sports and Art lens ranges

Premium third-party lens manufacturer Sigma
announces two new lenses for L-mount and Sony E

A‘ Sigma has announced two new
q 4 lenses for L-mount (shared with

w Sigma, Leica and Panasonic full-
frame mirrorless) and for Sony’s E-mount.
But that’s where the similarities end
between the new 500mm telephoto for
sports and wildlife and the 15mm fisheye
with a huge 180° degree angle-of-view.

The Sigma 500mm f/5.6 DG DN OS
| Sports is set to be about 60 per cent
lighter and 40 per cent shorter than
Sigma’s 500mm f/4 DG OS HSM | Sports
for DSLRs at 234.6mm and weighing
1.37kg (L-Mount). This is, in part, due to
its special exclusive low-dispersion glass
elements and precision-engineered TSC
(Thermally Stable Composite) materials
to help keep the size and weight down.
Also on the spec sheet is a high-speed
HLA motor and OS2 algorithm for fast
and precise autofocus with five stops of
effective stabilisation.

The Sigma 15mm f/1.4 DG DN Diagonal
Fisheye | Art is the world’s first /1.4
diagonal fisheye lens for interchangeable

full-frame consumer cameras. It boasts
an incredible 180° degree angle-of-view
(corner-to-corner) and a bright f/1.4
aperture. It also features a built-in rear
filter holder for gel-type ND filters, a lens
heater retainer that prevents heat strips
from slipping over the front of the lens

New Think Tank BackLight Sprint 15L

Think Tank’s latest photography backpack is the

perfect blend of style, comfort, practicality and price

Think Tank has just launched a new lightweight backpack for photographers on the go. With its
slim, compact design, the Think Tank BackLight Sprint 15L is aimed at photographers who love
to hike and explore. Despite its size, it can still hold a standard-sized mirrorless camera, such

as a Nikon Z7 1, plus three zoom lenses or several
shorter lenses and additional accessories, such as

a flash or filters. Fitted with two harness systems
for ultimate comfort, the chest and waist straps help
alleviate the weight from your shoulders.

On the front, there is a large 2L pocket for personal
items such as a wallet, keys or map. Two more side
pockets can accommodate a 1L bottle and a tripod.
There's also space on the front of the bag where you
can attach straps to secure a coat when not in use,
or even attach a drone.

As you'd expect from a bag designed for the
outdoors, the BackLight Sprint 15L has a durable
water-repellent coating on the exterior and a seam-
sealed rain cover is included for added protection
should the heavens open.

The Think Tank BackLight Sprint 15L is available
now in green or grey colour schemes, with prices
starting at £198.
thinktankphoto.com

and a unique manual focus lock switch.
Read our review on pl08 of this issue.
Both lenses are available from March
with the Sigma 15mm f/1.4 DG DN
Diagonal Fisheye | Art costing £1,859
and the Sigma 500mm f/5.6 DG DN OS |
Sports costing £2,779. sigmauk.com

In other news

More snippets of photography
news fromaround the world

NEW ROLLEI 35 FILM
CAMERA COMING 2024

A brand-new Rollei 35AF will hit
the shelves ‘as soon as possible’
this year. Designed and developed
by Mint Camera - a boutique
manufacturer of some of the best
instant cameras — the Rollei 35AF
started in 2022 as a project to apply
Mint's ability to engineer brand
new instant cameras to the world
of 35mm film. The new model will
feature Lidar AF and cost between
£515-630 ($650-800).

VILTROX 2024 ROADMAP
Chinese lens manufacturer Viltrox
has revealed it plans to launch four
new lenses in 2024. The lenses
include a Viltrox AF 40mm /2.5
for Sony FE, Nikon Z and Fuijifilm X,
then there’s a Viltrox AF 56mm /1.7
for E, Z and X mounts, followed by
a Viltrox AF 16mm /1.8 for Nikon Z
and the fourth lens on the roadmap
is a Viltrox AF 135mm /1.8 LAB.
The latter sits in a new LAB series,
denoting ‘ultimate image quality’.
Pricing and availability are TBA.

© Think Tank

1




YOUR IMAGES

STORY
~HIND
ESTIL

Photographer: Louise B
© @louiseb.photography
Website: louisebphotography.com
Image location: Home session, London
Type of commission: Commercial
Shot details: Nikon D750, Nikon 50mm
/1.8,1/200 sec, /2.8, 1ISO 320

About the shot: As a photographer who specialises in
family and newborn images, Louise’s timeless images
aim to tell a story about each family. She does this by
creating a relaxed and organic atmosphere to capture
the raw beauty of the special bond between family
members. “If the subjects aren’t fully relaxed, then it
shows,” Louise says. “But taking a short break to reset
can really help.” Lots of patience is required, especially
with newborns but, having young children of her own,
she understands what's required to get the balance
between the perfect shot and a happy and calm family.
Louise prefers working in her clients’ homes and
shooting with natural light. “For this shot, we were in
their apartment, which had high ceilings and was flooded
with natural light,” she says. “Capturing babies and young
children requires you to increase your shutter speed
as there are sudden movements and changes in facial
expressions.” With her background in design, Louise uses
a mixture of textures and fabrics to create further depth
and interest. “The new mother chose a beautiful dress
from a collection | have for these sessions. The delicate
sleeves add a touch of elegance to the image,” she says.
In post-production, Louise carried out some basic
editing steps, adding some texture around the newborn’s
hairline to ensure she visually dominated the frame.
“Newborns tend to have a red undertone to their
skin, which quite often has patches and pimples, so
| took the saturation down along with the texture,” she
explains. “Once | had removed the main blemishes,
the skin appeared much smoother but | avoided heavy
airbrushing to keep the subject looking natural.”

Right
New Beginnings
Louise aims to capture the essence of
how a newborn fits into the family unit,
receiving plenty of love and attention

12




STORY BEHIND THE STILL
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Peter Fenech meets Isobel
reenhalgh to discuss accessibility

n photography and how small
hanges can make a big difference

Il main images © Isobel Greenhalgh




’ The term *anything
‘ for a photograph’ is
‘ used quite a lot. Many
professional photographers will
find themselves walking several
miles to remote locations, lying
on the floor of a studio or
contorting into odd positions
to get the perfect shot for their
clients, resulting in a few aches
and pains in the following days.
However, few of us put much
thought into what it must be
like to work with a disability in
this industry and the additional
challenges this involves.
Furthermore, in our quest for
the perfect image, it is easy to
forget the toll this may take on
our subjects themselves and
the discomfort this could inflict
if they too have physical or
mental health conditions.

Isobel Greenhalgh

Manchester-based Isobel Greenhalgh is

a commercial and portrait photographer,
image retoucher and creative who specialises
in photoshoots that are accessible to clients
with additional needs. Her colourful style is
contemporary and heavily inspired by modern
concept art. Isobel strives to raise awareness
of accessibility issues in photography and as
a working professional who is dealing with chronic illness herself,
she is well-positioned to understand the community she serves.
isobelgcreative.co.uk (9) @isobelgcreative

Photographer Isobel
Greenhalgh is on a mi
to spread the word ab:
how disability can impact the
photography industry and to
raise awareness of how we can
make things better for people
working on both sides of the
camera. | meet Isobel at a
studio space on the east side
of Manchester, housed in a
marvellously atmospheric old
textiles facility. Isobel jokes
about the lift being broken
and as we climb several flights
of stairs, | already see how
this could present a problem
for clients less able-bodied.
| start by asking her about the
common accessibility issues.

“Unfortunately, regulations in
this country favour buildings
over people,’ Isobel says. “Many

15
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buildings cannot legally have
required accessibility alterations
made to them. This is a huge
barrier. It makes finding locations
that are suitable for everyone
almost impossible. That's
either because they don't exist
or because those that do are
woefully expensive,” she adds.
“That's the biggest issue
for people on both sides of
the camera. There have been
occasions when | can't work with
someone simply because the
building is not accessible. That's
always hugely disappointing.”

Isobel herself is neurodivergent
and disabled although, as is the
case with many disabilities, this is
not visibly obvious. She tells me
that after years of misdiagnosis,
she was only recently discovered
to have Coeliac disease, which
has impacted her physical and
cognitive abilities and, in turn, her
personal and professional life.

“After my diagnosis, | was able
to look back and everything made
sense. | cut gluten out of my diet
and the brain fog lifted — | was
able to think creatively. | thought

‘Wow, | can problem-solve on the

spot now!" It's only been in the
last few weeks that I've realised
just how debilitating that was for
so long,” she says.
“Now my mind is clearer,
| can see how all the years of
accumulating techniques and
working the way | did has resulted
in the style I'm known for, which is
largely whacky bright colours.”
The years of physical pain have
also spurred Isobel on to work
with chronically ill subjects or
those who suffer from a variety of
ailments. Her model today, Bunny,
arrives and it's immediately
clear that the tone of the shoot
is going to be full of energy. As
the photographer and model



ne a bit to support

elr needs goes a long
way to making your
client feel comfortable™




get to work, Isobel explains that
her experience of professional
life and disability has made

her passionate about making
photography as fun, safe and
comfortable as possible and that
this starts with understanding
your client.

“Photographers often don't go
into much detail about what a
shoot with them looks like. On my
website, | have a post that goes
into exactly what's involved in my
complete process, such as when
people can expect to hear back
from me and what the workflow
looks like. Having that knowledge
can be really relieving for people
who need to plan every little
detail,” she explains.

Bunny is a complete pro when
it comes to posing and has an
almost otherworldly quality that
fits perfectly with Isobel’'s setup
today. Isobel takes some test
shots and then starts working on
multiple angles. “Posing is another
area that many photographers
don't provide much assistance
with,” she says. “Usually, I'd
go into depth with my posing

guidance, using mimicry to show
exactly what | want the shot to
look like — where to put their
hands, how they should angle
their knees and where to place
their shoulder. It's not something
| can show off in the studio today
— our model is fantastic but I'm
not good with my left and right,
so | do a lot of gesturing. I've been
told by subjects that this is a
huge help. | often get people into
a specific pose, then tell them to
‘shake it out, meaning that they
should get in a similar pose but
relax, without looking stiff.”

Isobel jokingly explains that the
reason she is constantly moving
is due to her joint discomfort and
she and Bunny share stories of
their respective illnesses. There
is clearly a rapport here and
Isobel isn't afraid to underline the
shared experiences on both sides
of the camera lens.

“I'm part of the community
that | serve so, in some ways, it's
easier for me as | understand
them. If you're outside that, you
may have to make yourself known
as a safe person to work with.”



As Isobel adds a red gel to
her main light, she explains that
supporting disabled subjects
needn't be inconvenient or
impact your business.

“Don't be afraid to ask people
what they need. Have a dialogue
with them as you normally would
and use those conversations
as an opportunity to ask if they
have any special requirements.
These might include accessibility
or sensory needs. Are there any
materials they can't tolerate?
Are they okay with flash? If there
is makeup involved, are there
any skin sensitivities you should
be aware of?

“What are the sound and light
levels like in your studio — would
your subject be okay with
background noise or prefer it to
be quiet? Let people know that
you don't have a ramp or lift or
an accessible toilet. There are so
many things you can potentially
consider that it's better to simply
ask what your client needs from
you," Isobel explains.

“You don't need to know every
disability out there. Even if you

can't accommodate them fully,
then be willing to meet them
halfway on something.”

Bunny tries another pose and
Isobel instantly knows to reach for
her prism, which she attaches
to the filter thread of her lens.
After another test shot, it
becomes apparent that the
shoot has found its rhythm.

Tips for accessible shoots

@ Communicate

Talk to your clients about their
needs during your normal
onboarding process, asking
about special requirements.
Be honest if you can't support
disabled access with a ramp or
lift, and enquire about sensory
discomforts and preferences.

@ Supporting information
On your website, provide a
breakdown of what a shoot
with you normally involves, for
example, how long it normally
takes, where you can travel to

and what style of shots you
normally like to capture. This
allows less able-bodied clients
to decide if there is anything
they might need to ask you
ahead of a shoot. Offer an
introductory questionnaire
people can fill out with anything
you might need to know but
that they may not feel able to
bring up in a conversation.

© Take regular breaks

If you suffer from any conditions
that cause fatigue or pain,
don't be afraid to take breaks

ALL ACCESS

throughout the shoot. You can
use this time to show your
clients some of the images
you've already captured or offer
them a coffee so that everyone
is recharged and the pacing of
the session is consistent.

@ Do your research

Prepare to make your shoots
more accessible by looking into
shared symptoms of common
conditions. This will make

you appear more receptive to
requests and can uplift your
business in return.
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“That looks so cool!” says Isobel.
While Bunny is accomplished and
able to work to Isobel's style, it's
important to know the subject’s
limits. “Do a risk assessment
of your own space, beyond the
basics. Do some research into the
most common issues people have
that you might encounter,” Isobel
says. “A lot of disabilities have
overlapping symptoms, so you
can consider a range of people
by making one small change.

Just knowing that you've done

a little bit to support their needs
goes a long way to making your
client feel comfortable.

For a final adjustment, Isobel
adds a colour LED light to the
setup. I'm interested to know
how intense work such as this
impacts her own well-being. After
all, taking good care of yourself
as a disabled photographer is
just as important. “I build rest
periods around everything that
| do. It's all paced. However, this

has to extend to my personal life

as well as my professional. If don't

consider both together, | burn out
really quickly and have to take
long periods of rest. I'd rather
work two days a week than have
extreme instability of cash flow,
which we all have to deal with
already as freelancers. If you

have to take a long time off,

tasks build up really quickly.”

It's a reasonable assumption
that many photographers with
neurodivergence and disabilities
are intimidated by working
professionally. | ask Isobel what
advice she would give to them
from her experience.

“Be brave! | had this image in
my head of what the professional
industry looked like, but once
you start talking to people, you
realise that you don't need to put
a mask on when you're working
just to create a false sense of
professionalism. Clients are a lot
more forgiving than you think.

I've asked to take a break many
times and nobody has said no. It's
actually endearing and humanises
you on set.”

As the shoot winds down, I'm
humbled by Isobel's enthusiasm,
positivity and dedication to her
clients and her peers.

“| try to be as inclusive with
model choice as possible, but in

a way that feels organic. | want

it to seem natural and not just
like we're trying to hit diversity
quotas. | make the effort to work
with as wide a group of people
as possible. It all ties in together
— accessibility, inclusivity — if you
start with these now, it makes
the industry better for everyone
involved in the long term.”
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LANDSCAPE POST-PROCESSING

to start. Modern image editing software
ites offer a wide range of

.

e headlines

Pictured

Natural balance

With careful and targeted
adjustments in pos

processing, you can turn

your landscape images .

into shots that stand out
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Create a baseline

Liam Willis on adjusting your RAW files to provide
the best opportunities for later creative processing

One of the aspects you come to appreciate
as an experienced digital photographer
is that editing is a multi-step process.
It's not simply a case of taking the images
from a camera, applying a standard set
of adjustments and then sending the files
to print or archive.

To create the best possible results, it
is almost always necessary to ‘pre-cook’
images in RAW processing software,
before applying more complex local edits
and finally, retouching in applications
such as Photoshop or Affinity. Landscape
photographer Liam Willis keeps his editing
process refined and targeted, integrating
his shooting and editing workflows.

“Like thousands of others, | travel the
length and breadth of the country in search
of the perfect shot. | take inspiration from
other photographer’s work but | also like to
give it my own style; slightly changing the
focal length, adjusting the composition or
even the exposure length” he explains.

“My tutorial will take you through my
editing process of Tu Hwnt I'r Bont, a
tearoom next to a bridge in Llanwrst, Wales.
| picked the wettest week of the year, with
the River Conwy bursting its banks. | used
an exposure length of 0.5sec and shot at
/22 to give some movement to the water.
| choose to edit using Adobe Lightroom for
iOS on the iPad, as | don’t own a laptop.”

Liam Willis

Liam Willis is a
wildlife and landscape
photographer based in
Sussex, UK. He took up
photography in 2015,
focusing on nature
& images, but developed
a passion for landscape photography.
In 2023, Liam was shortlisted for UK
Landscape Photographer of the Year
and The British Wildlife Photography
Awards, and his picture of a stag

‘Morning Breath' was a finalist at the

British Photography Awards in 2023.
@mrliamwillis
liamwillisphotography.sumupstore.com

g Pictured

g e Down to the details
RAW images often contain

far more highlight and

shadow detail thanis

immediately apparent

before processing. This can

be easily recovered using the

Basic Panelin most apps
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Balance tonal range

Apply firstwave adjustments to RAW files for a moody base image

Below

Washed out

The original shot appears
overexposed and lacks
depth. It wasn't entirely
level either, so required
straightening by 0.13°
degrees clockwise

Right

Final touches

Liam removed the sign
for the gallery on the right
using the Remove Toolin
Healing. The final shot is
now perfectly balanced
forany further treatment

Find a

Balance Firstly,
| reduced the
Exposure and the
Highlights to bring
out more of the
details that had
looked ‘washed
out’ in the lighter
RAW file. This gave
more depth to
the background
and gave more
layers to the shot.
The increase in
contrast will give
better clarity when
enhancing colours.

Apply

Healing
| spent some
time removing
dust particles
and spots before
any final touches.
This is important
as it removes
any distractions.
Light colours
often make them
invisible in a RAW
image and they
are more visible
when the Exposure
is reduced and
Dehaze increased.

AFTER

v Color

WwB Custom

Masking

Light

Color

Effects

~

Colour

Vibrancy It's
easy to over-toggle
the Temperature
and Tint bars to
make something
extra vibrant and
completely change
the colour of the
image. | used
them slightly on
this to improve the
existing colours.
| also used the
Color Mix to bring
out the vibrancy
in the autumnal
colours.

Masking

Part 1 Firstly,
the sky — find
a balance in the
exposures and
colours. Here,
| added a mask to
the sky, increasing
the Dehaze and
reducing the
Texture, allowing
the weather to be
evident but also
to blend in with
the rest of the shot
by removing the
previously ‘washed
out’ looking sky.

LANDSCAPE POST-PROCESSING

Masking

Light

Color

Effects

Sharpness

and details
For this shot,
| increased the
Dehaze slightly
for a darker and
more vibrant finish
but also reduced
the Texture to
give it a smoother
look. | opted not
to add a Vignette
to avoid taking the
detail away from
the flowing river,
as that's also an
important feature
of the shot.

Masking Part

2 Secondly,
the river —as a
vital part of the
image, | wanted it
to have the right
effect. | used a
long exposure
so | wanted that
motion to be
evident. | then
increased Clarity
and Dehaze
to enhance
the movement.
Texture is reduced
in line with the
rest of the image.

© Liam Willis
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Create with colour

Enhance the natural beauty or create a particular
mood with colour adjustments, says Mark Brion

The range of colours visible in a landscape
scene is vast. Even under flat lighting or in
seemingly drab locations, there are a plethora
of analogous colours hiding in the scene —
subtle variations, the sum of which creates

a natural palette that the human eye can
identify and relate to. This spectrum can be
both a blessing and a challenge.

It's one of the aspects that makes
landscape photography so appealing but also
means that becoming a deft hand at post-
processing is a crucial skill. Over-working
colour can break down the smooth gradations
we're accustomed to seeing and introduce

uncomfortable jumps and shifts which instantly
make the scene look strange and unattractive.
“Colour adjustment is a vital aspect within
post-production and plays a crucial role in
enhancing and refining landscape images,”
says nature photographer Mark Brion.
“Remember, the goal of adjusting colours in
a landscape photo is to enhance its natural
beauty, evoke emotion or convey a particular
atmosphere,” he adds. “Experiment with
colour adjustments in post-processing, whilst
keeping the scene intact. Assess your changes
to ensure that they complement the overall
aesthetics of the landscape image.”

Colour grade to perfection

Balance grading to create images with maximum tonal separation

Inset right

Flat colour

| was struck by the
vibrancy of the red mud
inthis scene but it doesn’t
showthrough in the
out-of-camera shot

Right

Super separation

By selectively editing each
colour channel and toning
down the green leaves,
the soil and bronze foliage
stand out more, giving
the image added three-
dimensionality

Black and White Points Most RAW workflows should start by

setting the Black and White points, which define the tonal parameters
of the file. Hold down the Alt/Option Key to visualise when clipping
starts to occur, setting the sliders to just before warnings appear.

Use Point Color To target the underlying
reddish soil and brown foliage, | used the
Eyedropper in the Point Color tab in Lightroom

Adjust HSL We need to create separation
between the green foliage and the
bronze leaves and mud behind. | reduced
the Yellow Hue and Saturation, which makes
natural greens ‘fresher:. | also reduced Green
Luminance to remove the presence of sheen.

to see which colours were selected, then
further adjusted the HSL of these colours.
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to select this range. | checked ‘Visualise Range’

Grading wheel techniques For a subtle
split tone, | added green to the Shadows
and orange to the Highlights, using the Grading
Wheels in Lightroom. This complemented the
existing scene colours. To fill out the range,
| added a mid-tone halfway between these.



Tone Curve targeting Adding more
complex tones to the colour palette
ensures that the grade looks natural. Using

a Tone Curve, | added more green to the

Darks, Magenta to the upper Midtones and

Yellow to the Highlights, creating a warm glow.

S

Control Calibration Finally, | made

some minor adjustments to the Color
Process by increasing the Green and Blue
Primary Saturation and shifted the Green
Primary Hue to the right. This finished off the
cinema-like grade style | was looking for.

/

© Peter Fenech

LANDSCAPE POST-PROCESSING

Mark’s most-used
editing tools

Top tools for editing landscape shots

WHITE BALANCE

| often use the Basic Panel sliders in Lightroom
to correct the colour casts, adjust the colour
temperature of the scene and control the

Tint for a more natural range of colours.

SATURATION AND VIBRANCE

| use these tools to enhance or tone down
colours, as they impact all colours and the least
dominant ones, respectively. For more precise
control, use Point Color or other sampling tool.

Fine-tune specific colours to achieve the
desired look. The Hue, Saturation and
Luminance sliders alter the shade, intensity
and brightness of each colour range.

COLOR GRADING

This will influence the impact of the image,
based on the depth of colour. Independently
add or neutralise colours in the highlights,
mid-tones and shadows.
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Craft lighting
and exposure

Control tonal balance using local adjustment tools

Exposure and colour in photography are

often discussed independently as if they are
unrelated topics, however, it is important to
remember that the brightness of an image
directly impacts the appearance of colours. In
landscape photography, the decision is often
taken to underexpose slightly to maintain
highlight detail but also to create richer colours
that appear more saturated. This means that
you need to be mindful of how your exposure

choices affect the colour fidelity of your photos.

In scenic imaging, this can be challenging
due to the tonal range of many compositions.
The sky is usually brighter than the foreground
by a significant margin, which means colours
will be impacted differently in each area of the
frame. This is why localised adjustments are
hugely important in landscape editing.

Most advanced software applications offer
adjustment tools that allow localised edits
to many parameters, including exposure,
colour saturation, white balance and clarity.
This workflow is far more flexible than when
applying global adjustments. However, when
we make changes to the tonality of an image,
especially in local areas, we must keep the
dynamic range natural. We must also ensure
that we do not change the lighting structure of
the shot, creating hotspots where none could
exist in reality due to a lack of light source.

A professional approach is to work in rounds
of edits that get progressively more concise.
Start with global edits, then move down to
working using local adjustment tools, before
finally targeting the brightness and intensity
of specific colour ranges.

Perform complex blends

Merge images with challenging moving elements and tricky lighting

BPeE

Auto blend shots In this high-contrast
scene, | captured a bracket of three
exposures, which | then blended together
using Lightroom'’s Merge to HDR function.
This did a good job of loading all of the tones
into a single frame for later adjustment.

Restore natural colour After adjusting

the Temperature of that range, the greens
remained an ugly brown, so | adjusted them
using HSL, increasing the Green Hue until the
colours looked more natural. | also applied
+33 Green Primary Hue under Calibration.
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Adjust main parameters On the
merged image, | set the Black and White
Points, introduced some extra Clarity and
pulled back some of the highlight detail.
| toggled the Clipping alerts by clicking on
the triangle symbols on the Histogram.

L e

Remove ghosts The moving water has

created blending artefacts, so | stacked
the HDR file and one of the original bracketed
images in Photoshop. | made a selection
around the foreground water in Quick Mask
Mode, feathered it and applied a layer mask.

Adjust tonal shift The use of a strong
ND filter has given the image a yellow tone.
| wanted to remove this from the shadows,
so to target this range, | created a Luminance
Range Mask, selected a highlight with the
eyedropper and refined the Luminance Range.

Create a light gradient For a sunset

feel, | added a Radial Gradient layer with
a yellow foreground and magenta background
and applied Soft Light Blend Mode. For a
smoother gradient, go to Layer Styles and, in
Blend If, move the Underlying Layer Handles.




ocalised adjustment
“the image now contains
much more detailand
__the dynamicrange
,.still looks natural

-5

BEFORE

: Pictured

On stream

 The exposurerange in
" this shot is wide but the
topography results in
isolated areas of clipped
detail, making the use of

grad filters impractical

© Peter Fenech
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Pictured

Maximum impact
If getting people to
connect with your final
image is the ultimate goal
as aphotographer, we
should be freeto use al
tools possible to help tha

ork with special effects

Explore advanced software techniques to make your shots stand out

Landscape photography can often be seen

as a literal genre, merely tasked with capturing
the scene before the camera exactly as it

is. However, this attitude has changed over
recent years, thanks to the advent of social
media trends and Al software features such as
Generative Fill in Adobe Photoshop. Although
these tools have been controversial and have
stretched the definition of digital photography,
they have also opened up a whole world of
creative and cultural possibilities.
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| have always believed that the impact of the
final image is the end goal for a photographer
and that we must be free to take whatever
steps are necessary so that the viewer can
connect with our subject. If that means
adjusting the colours and lighting conditions
of a scene because they had less impact on
the day we conducted our shoot, or because
we had to shoot at a sub-optimal time of day,
we should explore all the possible options to
enhance our images.

Modern software is packed full of filters and
advanced functions, such as layer masking
and gradients, which can be used to simulate
exposure effects. The key is to use them with
restraint and only apply filters where there is a
clear advantage in doing so. Special effects, as
in any photo genre, aren't necessarily enough
to justify an image on their own. Instead, they
should enhance the lighting and detail already
in the scene, or complement the intended tone
of the shot, at the moment of exposure.




rk Brion

Mark Brion is an
award-winning
photographer, based
in Oxfordshire UK.
He served in the
British military and
the police, before
becoming a pro

photographer in 2013. Initially, he
worked in events, portraiture and real
estate before specialising in natural
world imagery. Teaching photography
is now Mark's passion and he leads
workshop groups to destinations
both in the UK and internationally.
@markbrionphotography
markbrion.com

Use filters like a pro

Other special effect tools to try on your images

DIFFERENCE CLOUDS
In Photoshop, go to Filter >

Render > Difference Clouds.

This applies a fog-like
effect that can be scaled,
transformed and blended
using the Screen blend
mode. Use this at

an Opacity of less than 40
per cent and ensure the
scaling matches the focal
length of the frame.

RADIAL BLUR

When shooting in the
middle of the day, it can

be a challenge to achieve

a long exposure without
using a 10-stop ND filter.
Select the sky and with the
selection active, choose
Filter > Blur > Radial Blur.
Select Zoom as the method
and adjust the Amount

to suit your image.

DIFFUSE GLOW

For a fairytale look, this
filter subtly diffuses the
highlights, creating a
soft-focus effect. Use
this sparingly on high-
key images or those with
a defined light source.
Alternatively, go to Select >
Color Range, sample

a highlight and add

a light Gaussian Blur.

© Mark Brion

LANDSCAPE POST-PROCESSING

Relight the scene

Introduce lighting effects to your
shots to overcome flat conditions

Add a movable layer Start by adding

a Black Solid Colour layer above your
Background layer. The black background
will make it easy to move the lighting effect
around at a later stage. You can toggle the layer
on and off using layer visibility.

Add a flare The process varies between

software, in Photoshop go Filter > Render >
Lens Flare. Select the 105mm Prime option,
resize using ‘Brightness’ based on the focal
length and resolution of your image and place
the flare where your light source would be.

Remove the background Click OK and

the filter is applied. Change the layer
blend mode to Screen to remove the black
background and then adjust the placement
and size of the flare layer. Consider the
ambient lighting and match its direction.

- ——

Match the ambient colour Tone the flare

layer to match the ambient colour balance.
Go to Layer > New Adjustment Layer > Hue/
Saturation and, with the flare layer below, use
Layer > Create Clipping Mask. Check Colorize
in the H/S dialog and shift the Hue slider.
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ABST

Think outside the box to cross the line from
reality based images to mesmerising photo art

Words by Kim Bunermann

bstract photography is

a dynamic and varied

genre that presents

endless opportunities to

explore and unleash your

creativity. In the early days
of photography, there was little room for
abstract frames. The first cameras served
the sole purpose of capturing scenes
as they appeared in real life, providing a
more accurate depiction than paintings.

However, like most art forms,
photography evolved and began to find
its creative voice as a reaction against
expressionism in the 1920s, when
photographers such as Albert Renger-
Patzsch freed the medium from its initial
function. This period saw the emergence
of movements such as New Objectivity
and New Vision, where photographers
embraced a fresh approach to discovering
the technical possibilities of photography
to showcase structures, forms and angles
in innovative and exciting ways.
To create frames that offer a fresh

and unique perspective on familiar
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subjects, the key is to break away from
preconceived notions by transforming the
ordinary into the extraordinary. This often
means removing subjects from their usual
context, which renders the functions of
objects less important. Instead, the focus
shifts to the optical characteristics of
materials and colours.

To experience subjects in a new and
extended way, we need to train our eyes
and develop the necessary observation
skills, while also trusting our vision.
Breaking traditional photographic rules
is an important part of this process, even
though it may be easier for some than for
others. However, abstract photography
is a genre that allows us to have fun,
experiment and discover.

Over the next few pages, we’ll explore
some abstract techniques that you can
adapt to other photographic genres and
let you showcase your creative side. We'll
show you how to find fresh perspectives
on everyday objects and familiar scenes,
showing you how to transform them in
a game of hide and seek with the viewer.



SHOOT ABSTRACT

RACT

Pictured

Cut loose

Photography can be more
than arepresentation of
reality. It can transform
subjects in a way that
opens up anew level of
perception for the viewer
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Train your eye to detect the hidden
visual qualities of everyday subjects

Any image that does not show reality can be
considered abstract. Although people might
perceive the level of abstraction in different
ways, as long as the photograph causes the
viewer to question what they are seeing, it can
be considered a successful abstract frame.
The easiest way to portray any subject in
an abstract way is to free yourself mentally
from its concepts and functions. Abstract
photography doesn't have to explain what is
depicted - in fact, the aim is not to do so.
The most important skills required for
abstract photography are observation and
perception. Freeing your mind from the
functions that the material world and society
have ascribed to the object you are shooting
means you can alter the subject’s context
from its reality. To do this, select an item of
your choice and observe and analyse it. Take
your time, turn it, get closer and see how
it looks in different lighting. Work out what
makes the object interesting or unique and
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concentrate on enhancing those features.

Try doing this as a weekly challenge, with

the aim of training your mind to look out for
possibilities and also to become more familiar
with the way your camera and lens work.

In terms of the composition, aim to give the
viewer a direction to explore the image, using
leading lines and a strong focal point to guide
their eyes. While traditional composition rules,
such as the rule of thirds and the golden ratio,
are handy, it's good to think more abstractly.

Especially when you are filling the frame
with the subject, leading the viewer's eye is
crucial. Start by taking a wider shot of the
subject and then get progressively closer
with each photo. This will help you identify
where the leading lines and other visually
dominant elements are in your frame. Keep
getting closer until the composition of the
frame provides the viewer with a mystery to
solve, where the subject is transformed and
incorporated into a supporting composition.




BREAK
THE RULES
When it comes to abstract
photography, the sky's the limit.
Experimenting and overlooking
the classic photography rules and
techniques, for example, in terms
of the shutter speed, will help you
make even the most ordinary
subjects appear mysterious
and interesting.
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transform everyday
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image elements

Bringing elements closer together
can help you to manipulate reality

Depending on the subject you want to
transform, a telephoto zoom lens can
be a great tool. Due to its versatility,

it allows you to explore scenes with a
different approach and from a different
perspective than a macro lens. A zoom
lens has more to offer, especially when
photographing architecture. Due to its
compressed perspective, the foreground
and background appear closer together
at narrow focal lengths.

However, telephoto zoom lenses
aren’t cheap, and to avoid going
over your budget, it's a good idea
to consider second-hand options.
MPB is one provider of pre-used
kit that carries out checks on the
functionality of a lens before it
goes on sale online. The Canon
EF 70-300mm f/4-5.6L IS USM,
for example, is a relatively
budget-friendly professional lens
with rapid, virtually silent autofocus.

—
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Isolate for
alienation

Get up close to your subjectand
frame tight to discover fresh
perspectives on ordinary items

A popular method for creating abstract
frames is to isolate the subject from
its surroundings, offering the audience
a different view that deviates from
reality. One way to achieve this is by
incorporating negative space to give
the subject room to breathe or to take
close-up shots to fill the frame to the
maximum. The latter allows the viewer
to focus on the unique features of the
subject’s material and colour.

Here, macro lenses with at least a 1:1
reproduction ratio are recommended,
such as the budget-friendly AstrHori
25mm /2.8 2-5X Ultra Macro optic.

It can focus down to 113mm at 2x
maghnification or 186.4mm at full 5x
magnification. However, if you are

new to abstract photography, most kit
zoom lenses are also suitable for this
technique. Often these lenses have
decent close-focusing capabilities, and
when you capture the subject in RAW
format, you have the option to crop the
frame even further in post-processing.

To achieve the best results while
maintaining high quality and sharpness,
choosing an aperture of f/8 works best.
As the depth of field can be shallow
when using a macro lens, even if you
are working with narrow apertures, the
focus stacking technique comes into
play. This approach is highly effective
when capturing still subjects and
involves stacking several images
at the post-processing stage.

SHOOT ABSTRACT

Stack shots for depth

Secure camera For the highest quality
image, go to the menu and select RAW
as the file format. To make the image stack
process perfect, mount your camera on
a tripod. Now activate the Live View to
decide on framing and composition.

Switch off AF Set your camera to

manual focus (MF) and turn off any
image stabilisation modes. In M mode,
select an aperture of /11, set the shutter
speed to around 1/200sec and adjust the
ISO until you achieve a well-exposed image.

»  Drive Mode
3 Self-timer: 2 Sec
=]
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Set the focus Select the two-second
self-timer or use a shutter remote release
to avoid camera shake and blur. Now focus
on a specific area, press the shutter and
continue without reframing the scene until
all the elements are covered.

Auto-Align Layers

Projection

O Auto Perspecive

erical

Lens Correction

Vignette Removal

Geometric Distortion

Stack in post In Photoshop, select all

layers and go to Edit > Auto-Align Layers.
Go to Edit > Auto-Blend Layers, choose Stack
Images, Seamless Tones and Colors and
Content Aware Fill Transparent Areas.
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Pictured

Light painting

Working with lightand

long exposures, combining
different coloured lights
and movements can

bring your vision to life
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Let there

be light

Use light to create
abstract frames

When creating photographs that deviate
from our perception of reality, the subject
is independently reshaped to create an
additional level of interest. This can be
achieved by adapting the material and

visibility of the subjects, or by using

photographic techniques. One such subject
is light, which offers great creative potential.
Light is a crucial tool for photography,
whether it's natural or artificial light from a
flash. It can be used to achieve different visual
effects and can be shaped and combined with
colours to create unique compositions. While
the light is more controllable indoors, sunlight
can also be great for creating abstract frames.
For example, a strong midday sun creates
high-contrast shadows that can contribute
to and become part of the composition.

1CHOOSE THE OPTIC

Or abstraetion

)

You can create a full-frame bokeh
with most lenses, but if your goalis
to achieve natural-looking, circular-

shaped light sources, anine-blade
lens is ideal. Lenses with fewer
blades create polygon-shaped orbs

Play with wavelengths

Create abstractimages that we cannot perceive with the naked eye

When taking an abstract
approach, an extended
shutter speed provides the
opportunity to get creative
with light, such as turning
an existing scene around or
constructing a conceptual
photograph. In both scenarios,
the light sources need to stand
out, so it should be dark.
One approach is to capture
the light of moving objects,
such as cars, to create light
trails. You can also move
the camera to control the
shape of light sources -
this approach is called
Intentional Camera
Movement (ICM)
and we will explore
this further in the
following pages.
To bring your
vision to life, you
can create a scene
without access
to a photo studio
- all you need is
some space and

a flexible LED light source with
a bundled light cone. For this
project, you need a tripod to
keep the camera steady and
avoid blur but you won’t need
a shutter remote as the self-
timer function will work.
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4 3DIALIN CAMERA SETTINGS
ShootinM and deactivate the AF
function. Now choose the maximum
openaperture setting and adapt the
shutter speed and ISO values until
the exposure is balanced. When
working in the dark, using a tripod
allows you to use longer exposures.

Prepare yourself by wearing
black clothes, including black
gloves, to help you to blend
seamlessly with the dark
background. Set your camera
to manual mode (M) and
choose a shutter speed of
3sec to start. Bear in mind

that autofocus and auto-
exposure hardware
in most

SHOOT ABSTRACT

2 FIND THE SCENE

Light sources in the dark, forexample,
street lights or coloured fairy lights in your
room make great subjects as they are
naturally colourful with lots of high contrast.
The effect works bestwhen the light
sources aren'toverlapping each other

4 CREATE THE BOKEH

Frame the scene and defocus to the
maximum. To enhance the bokeh,
decrease the distance to the light sources.
The further away you are, the more
intense the effect will be. Experiment

and try different compositions to frame
the colourful light orbs.

cameras are not designed to
work with monochromatic
light. To ensure sharp images,
choose an aperture of around
/8. Activate the self-timer
and position yourself in front
of the camera. Now, move the
light source around to create
different patterns. Be creative
with shapes and use coloured
light to mix things up. This

technique may take some time

to perfect, as you will need to

balance the exposure time and

figure out how fast to move
the light source to achieve
the desired effect.
Coloured LED lights
can be tricky to shoot
because colours have
different wavelengths
that affect their
visibility. For instance,
blue LEDs have shorter
wavelengths than red
ones. As a result, you
need to widen the depth
of field to ensure that they
appear sharp and in focus.
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Add optical effects

Achieve abstraction by using your camera and lens in a different way

The joy in creating scenes that don't depict
reality is that you can experiment by playing

around with both the camera and the subject.

Intentional Camera Movement (ICM) is

one technique that is especially popular

in woodland and nature scenes to add a
dynamic and painterly style. This approach
works by setting a longer exposure time

and moving the camera while the shutter is
open. These images often have a captivating
abstract blur that conveys a sense of
movement while blurring colours and shapes.

Create a zoom burst

1DECIDE ON OPTIC

The longer the available focal length of
azoom lens, the more intense the effect.
Lenses with a flexible range of 70-300mm
are ideal, but this technique will also
workwith slightly shorter focal lengths

3 PRESS THE SHUTTER

This technique thrives on vibrant colours
and structures that the captured scene
should provide. A beach scene, sunset or
flower field are other great subjects that
may also create an intense effect. When
deciding on a subject to capture, analyse the
scene and the direction of lines, and work
out what type of movement will enhance the
subject. This is often achieved by adapting
the subject’s shape in the movement, for
example, imitating the lines of the tree
trunks by moving the camera up and down.

Click the shutter and have one
hand ready on the lens to zoom
inor out of the scene —or do both.
Iflonger exposure times benefit
the look of yourimage, attach an
ND filter to balance the exposure

As the name of the technique suggests,
there are no rules in terms of the camera
movement. However, it's useful to know
what type of movement creates each effect.
To achieve a panoramic glide effect that
generates a multitude of colours, move the
camera from side to side. A drop motion
can be created by mounting the camera on
a tripod and moving the camera via a fluid
ball head or tripod handle downwards. If your
camera is already on a tripod, it's also worth
trying the 360° rotation effect.

’/

2 BALANCE EXPOSURE

To avoid overexposing yourimage,
use aclosed aperture of around f/22.
Start with a shutter speed of 1/13sec
and experimentwith this settingas it
will depend on how quickly you zoom




Shoot without a lens

Go back to the early days of photography by creating
apinhole camera to shoot appealing abstracts

The camera obscura, also known as a pinhole camera, was the
first camera created and has been around since the fifth century
BC. As part of his studies on how we see, the Arab scholar Ibn
Al-Haytham is credited with inventing this camera, showing how
light can be used to project an image onto a flat surface.

The camera obscura works without a lens and it results in soft
and slightly blurred images. To make one yourself, you will need
a spare body cap, a drill, some aluminium foil, a needle and some
sticky tape. First, create a card or paper template of
the body cap by drawing around it and marking
the centre point. Place the template over
the body cap and drill to create the hole
with a diameter of around 2-4mm.

To create the actual pinhole, cut
off a small piece of aluminium foil
and carefully prick a hole. Bear in
mind that the smaller the hole, the
sharper your image will be. Use
a piece of tape to attach the foil
to the cap in the centre. Attach the
body cap instead of the lens and find
a suitable location for your shoot.

SHOOT ABSTRACT

Fake an ICM image

Use your lens filter to simulate camera movement

ICM is a great technique to
explore new visual possibilities
in a scene. However, mastering
this technique is important if you
have a specific idea of how you
want the final image to appear.
Finding the right balance between
movement and shutter speed
is key. But you can also apply
this effect in a more controlled
manner with simple and
inexpensive tools.

To achieve this, you need a
clear filter that does not affect

the overall image. A UV filter,
which is often used to protect
the lens against sand or water,

is ideal for this. These filters are
cheap, reusable and can be easily
cleaned. To simulate the effect
before shooting, you will also
need a jar of petroleum jelly,
such as Vaseline.

Once you have your tools,
mount your camera on a tripod.
It is best to activate Live View
mode to oversee the results.
Work with an aperture around /8
and keep your ISO value low by
adjusting the shutter speed until
a balanced exposure is achieved.
Attach the UV filter and smear
the petroleum jelly on its surface.

Control the effect by smearing
the petroleum jelly in a particular
pattern. Horizontal lines, for
example, will create vertical
blurred streaks. Start with a
minimal amount of petroleum
jelly and add more as needed.

If you are not satisfied with the
result, wipe the petroleum off
with a damp microfibre cloth and
dry the surface afterwards with

a different cloth.

Pictured

Turn back time
Shotwith a pinhole
camera, thisscene has
ablurred, abstract effect,
whichisincontrasttothe
sharpness of amodern
DSLR or mirrorless camera
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Combine movemen

2x © Raghuvamsh Chavali

B S L !

Raghuvamsh Chavali explains the technique of interlacing frames

Raghuvamsh Chavali

Raghuvamsh Chavali
is a nature and wildlife
photographer, originally
from India but now
living in Canada. His
photography involves
= travelling to remote
locations to create inspiring images
that capture the emotional energy of
the place. His work has been featured in
publications such as Canadian Geographic,
Smithsonian Magazine and Lonely Planet.
Chavali is also a researcher in digital and
biometric data and has patented a digital
watermarking system that incorporates
human biometrics into imaging systems to
help prevent theft. His academic work has
been published in international journals,
including the IJICS and the AJPCR.
raghuvamsh.com
@chavaliraghuvamsh
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One way of turning reality upside-down
is by blending together many images of
a commonly photographed subject, such as
birds. This technique of interlacing frames
has lots of potential for creating abstract
images and, by learning how to use it, you
can convey the natural movement of
animals in a unique manner, explains wildlife
photographer Raghuvamsh Chavali.
“Interlacing frames involves capturing
consecutive frames of the bird's movement
(see image above). The technique can be
used to create and showcase smoother and
more fluid motion when displaying bird flight
or other rapid movements using a burst
mode or video timelapse footage. With this
technique, the motion appears more natural
and less choppy, enhancing the experience.
“| frequently observe birds gracefully gliding
through the sky, creating picturesque scenes,
like artists with their brushes. It's captivating
to witness their flight patterns. While it's
common to spot them in nature, forests,
countryside and lakes, | find it intriguing to
see them in urban environments. | often liken

the journeys of humans to those of birds,
noting how both species navigate distinct
paths to reach various destinations.

“That's why | began capturing what | call
‘Wings Over Concrete; to create composite
photographs, showcasing these distinctive
flight patterns both in nature and urban
settings. To apply this technique, | choose
higher frame rates, such as 100fps, for fast
actions and complex manoeuvres of birds in
flight. When capturing regular flight patterns,
| use slower rates, like 50fps, to ensure
smoother playback. It's important to use
the highest resolution supported by your
camera, such as 4K, to capture fine details
of the birds’ movements and features. Use
manual focus to precisely control focus on the
subject, ensuring clarity in each frame.

“Then, set the frame composition before
initiating recording to capture the desired
scene effectively. | leveraged features, such
as the Sony A7Ill's MF Assist, which zooms
in when adjusting the focusing ring, providing
a clearer view for precise focusing on the
birds’ movements.”
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Pictured
In-flight movie
Toachieve this abstract

effect, Raghuvamsh
used multiple images
of birds in flight, adding
layers of interest

Pro Advice

Raghuvamsh's composition
and post-processing tips

EXPERIMENT WITH COMPOSITION
Embrace creativity by creating

your own unique compositions. Try
experimenting with different framing
techniques without worrying about the
traditional rules of photography. Your
composition should showcase your
personal style, making it recognisable
in the world of photography.

POST-PROCESSING MASTERY
Improve your skills in post-processing
by creating your own presets and
editing techniques. Add your personal
touch to every image through careful
editing, making sure your unique
style stands out in the final picture.

SHOOT ABSTRACT

Blending frames

Create one frame in post-processing

Import video

frames After
capturing your
video, carefully
align and blend
each frame
using specialised
image processing
software, such
as Adobe
Photoshop or
any other editing
tool. Go to File > Import > Video Frames to
Layers to import the footage.

Import Video To Layers

Range To mport
From Beginning To End

Limit To Every & Frames

Make Frame Animation

Set import options Now a setting

window will open. Here, it is important
to leave both the Selected Range Only and
the Make Frame Animation settings ticked.
For the best results, don't forget to enable
‘Limit to Every’ and select five frames.

Selective framing Now go through the
process of selecting the best frames
and eliminating any shaky ones. Ensure that
the final image is clear and crisp so that it
beautifully showcases the intricate details

and grace of the bird’s flight path.

Create

one frame
Thenit's time
to flatten
the image to
create one final
photograph.
For my work,
| convert the
image tones to
monochrome.
Instead of
changing the
Mode, go to Adjustments > Black & White
to gain more control of the tones.
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Mystical enveloping 3
The structure of the -
glass highlights a range
-

of colours and also adds Fa

extralayers of interest WIS
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3x © Ladoza

Shoot through glass

Ladoza explains how refracting daily scenes
through frosted glass can enhance your images

As a conceptual artist with a passion for
abstract art, Ladoza loves exploring different
mediums and techniques to create new
concepts. Photography remains key to this
process. “As with music, abstract art can
reflect our moods or embrace our feelings. It

shifts the importance of knowing what you are

looking at to how it makes you feel,” he says.
“The Viewing Glass project (the working

Jtitle) is still in its early days and with every

& shoot, | continue to learn what it is and see

46

how my objectives are evolving. My focus
isn't on the final piece, but rather on the
process and exploration of an idea.

“The concept came to me while | was
looking through a textured glass window.
Instead of seeing the window, | saw bold,
distorted shapes and colours, similar to
an impressionist painting. | was inspired to
create something that | could use to capture
the landscape in a way that looked like
a real-life oil or pastel painting.”

Ladoza is a multi-
media abstract and
conceptual artist, based
in Sheffield, UK. With a
passion for nature and
the outdoors, Ladoza
takes inspiration from
the surrounding landscape to explore and
develop new artistic ideas through painting,
photography and other media.
ladoza.co.uk (9) @ladoza.uk




THE
VIEWING
GLASS PROJECT
“| am looking forward to capturing
the landscape through the different
seasons as colours play a big role in
the outcome. | am also keen to explore
how the technique
can be used with
portraits and
still life
imagery.”

Turn your image into abstract art.

\

LONG EXPOSURE

Ladoza captured the scene using
anextended shutter speed. As a
result, the movement of the water
is softened, giving itadreamy
effect. This is acommon technique
inlandscape photography to

- transform outdoor scenes

Pro Advice

LLadoza explains howto create
abstractart through frosted glass

TRY, ANALYSE, REFLECT

Don’t ask yourself why you want to
create an image. This can get in the way
of producing it in the first place. If you
get an idea, try it out, then ask yourself,
how do you feel about it? What have you
learnt? How could you improve? That
way, you can reflect and learn from what
you've created and evolve from there.

CREATE A CONCEPT

Abstract art and photography is about
exploring your own concepts, not
necessarily complying with what others
want you to do. Knowing this can be
liberating and free you up creatively.

GET INPUT

There is a lot of value in being self-
critical, especially if you learn how to do
it constructively. Visiting galleries and
thinking about why you like — or more
importantly, dislike — a piece, can help in
the development of your own creations.

SHOOT ABSTRACT

SHOOT REGULARLY

People often say ‘Get out and shoot
more’ when talking about photography,
but not why this is important. We only
learn more by doing and reflecting.

The more we do something, the more
we learn from our mistakes and become
better at what we do.

USING GLASS FRAME
The glass effectis indirect
contrast to the background.
It becomes clear how

the structure of the glass
changesthe sceneintoa
painterly frame, setting the
focus clearly on structure
and colour of the subject
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Pictured

Transform colours
Infrared filters are
agreat tool for creating
abstract-looking
landscape images

Incorporate filters

Whatever abstract effect you want to create,
there's probably afilter that can help

© Ben Brain

UV filters, polarisers, and other similar filters
are commonly used to protect the lens or

to enhance the overall look of your image.
However, there are some specialised hardware
filters you may not have heard about. That's
probably because they are usually unsuitable
for every photo project, as they add distinctive
visual effects to the frame.

Infrared filter

IR filters don't affect the

subject’s form but its colours.

The tool cuts wavelengths Hay,
and permits transmission of

the red region of the light spectrum,

However, whenever you decide to
purchase a filter, it is important to consider
its material. Filters made from plastic are
often cheaper but they can negatively affect
the image sharpness. On the other hand,
more expensive high-quality filters are made
of optical resin or glass, which are less
prone to scratching, keeping up the quality

during regular use. Initially, you may wish to
purchase a budget-friendly filter to determine
whether it's worth investing in high-quality
filters later on. To give you an idea, here are
two unusual filters that can add an abstract
touch to your photography. Both effects

are also achievable in post-processing, but
attaching a filter will save you hours in editing.

Kaleidoscope filter

Many of us may recall playing with a kaleidoscope toy in our
childhoods - kaleidoscope filters work like those, creating a unique
visual experience like looking through one by splitting images into

AN
- - AP/
INFRARED (R72

fractions, mirroring them and rotating some elements. To create
this effect, the Subtle Kaleidoscope filter

from Freewell is an excellent choice,

resulting in frames that look surreal in their colours. When
using filters such as the Hoya R72, bear in mind that setting
the focus accurately before attaching the IR filter is a must.
These filters cut down the overall exposure, so working with
a tripod to slow down the shutter speed is advisable.

transforming ordinary subjects

into mesmerising and enchanting
artworks. To maximise the effect,
shoot colourful scenes with small
subjects and details, such as stained
glass windows or fields of flowers.

" SUBTLE KALEIDOSCOPE




HOPE
AND
HOMES
FOR
CHILDREN

Russia’s brutal invasion of Ukraine
IS not just a humanitarian crisis for
the Ukrainian people; it’s a child
protection emergency.

Up to 100,000 children warehoused in Ukraine's vast
orphanage system — a network of over 700 buildings - risk
being forgotten. Left to face the dangers of war alone as staff
flee. As families are torn apart or forced from their homes,
many more children are at risk of being separated from the
love and protection they desperately need. Worse still, they
are at risk of trafficking, or being placed in overcrowded,
understaffed and poorly resourced orphanages in border
countries.

We must act now.

Born out of the Balkans conflict 30 years ago, we've
championed the vital importance of family and
community-based care of children and our teams are on
the ground in Ukraine, Moldova and Romania to ensure
this war does not rob children of the love and protection
they need now more than ever. Across all three countries,
we're directly supporting displaced families and
unaccompanied children with material and emotional

Ok CHILDAE ®

I would like to make a donation to Hope and Homes for Children:

Reglstered with
FUNDRAISING
REGULATOR

Name Address

Tel Email

Ienclose a cheque for £ made payable to Hope and
Homes for Children or please debit £

from my credit/debit card (details below)
I would like to donate by debit/credit card

Visa Mastercard Maestro CAF card o
Card no. - - - -
Start Expiry Issue Security
date date NO.  pgestrg NO- on signature

only strip
Signature Date

URGENT APPEAL

support. We're working closely with authorities to keep
families together when they are at their most vulnerable
and to fight for the safe tracking, monitoring and care for
children without parental care. And we won't stop when
the fighting stops.

Will you help us by donating?

With your help, we can avert a child protection crisis of
epic proportions and ensure children are protected and
kept in families. Never orphanages.

To help protect vulnerable children, donate online at:
www.hopeandhomes.org/donate. Or call 01722790111
Monday — Friday 9am - 5pm.

Please quote FP22 - P&D when making your donation.
In the event that funds raised exceed what Is needed to deliver Hope and

Homes for Children immediate and longer-term response to this crisis, we
will use donations where the need Is greatest.

ﬂ{'ﬂ’ﬂd (t Make your gift grow by 25% at no extra cost to you

I want to Gift Aid my donation and any donations I make in the future or
have made in the past 4 years to Hope and Homes for Children.Iam a
UK taxpayer and understand that if I pay less Income Tax and/or Capital
Gains Tax than the amount of Gift Aid claimed on all my donations in
that tax year it is my responsibility to pay any difference. Gift Aid will be
used to fund Hope and Homes for Children’s general work.

Name of taxpayer Today's date

Please let us know if you would like to hear from us:
by phone by email
please tick here if you would NOT like to hear from us by post.

Please make cheques payable to ‘Hope and Homes for Children” and
send to Hope and Homes for Children, FREEPOST RTKX-TYLS-JHHB, East
Clyffe Farm Barn, Salisbury Road, Steeple Langford, Salisbury SP3 4BF.

You can view our privacy policy here www.hopeandhomes.org/privacy.

Registered charity (No.1089490) FP22- P&D
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S0, you've found a location for the perfect shot — but so has everyone else.
Kav Dadfar explains how long exposures can help you escape the crowds

For photographers, the frustration So how can you ensure your photos aren’t iconic landmarks into empty, almost surreal

of a pristine scene marred by inundated with crowds of people? One highly landscapes. The beauty of this method lies

distractions is a common occurrence.  effective solution involves the use of extremely  in its ease; with the right equipment and a
Whether it's busy crowds, moving vehicles or long exposures. By keeping the shutter open few considerations, any photographer can
onlookers in popular tourist spots or scenic for an extended duration, the motion in the use long exposures to enhance their photos
viewpoints, we have all experienced this scene blurs, effectively eliminating unwanted and avoid hours of editing work. Whether
frustration. While patience might secure elements from the frame. This technique you're capturing iconic cityscapes or serene
a gap for a clean shot, it's often unfeasible proves particularly valuable in crowded landscapes, using long shutter speeds opens
in continuously busy locations. scenarios, transforming busy city streets or up new realms of creative possibilities.

Words and images by: Kav Dadfar
Difficulty level: Intermediate
Time taken: 1.5 hours

S

Pictured

Far from the crowd
This image was taken at

a busy tourist hotspot but
by using long exposure
techniques, we managed to
escape the

What you'll need
Tripod
ND filters
Spare batteries
Image editing software




TOURIST TRAP

b

TETT

P N T




SHOOTING SKILLS
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Ensure everything is stable Stability is crucial when using slow Select a small aperture For long shutter speeds, the key is to

shutter speeds to blur out any motion as any slight camera movement limit incoming light by choosing a small aperture, such as f/14 or
can cause camera shake. So, to ensure that your photos remain sharp, f/16. Avoid going anywhere above /16, as extremely small apertures
mount your camera on a stable tripod on a solid surface. can lead to reduced sharpness due to lens diffraction.

Go with a low ISO Depending on how quickly the distractions Use a filter During the daytime, the main challenge will be to attain

in your scene are moving, you are likely to need an exposure of at a sufficiently long shutter speed. To overcome this, use a six- to 10-
least 30 seconds and possibly even longer. Alongside a small aperture, stop neutral density filter. If necessary, consider using stacking filters
expanded low ISO will also help you achieve longer exposure times. to achieve a long enough shutter speed that blurs out any movement.

Select live view mode When using DSLR cameras, mirror flips Don’t touch the camera Even pressing the shutter button can be

cause subtle vibrations. In long-exposure photography, this may detrimental to the sharpness of your photos in a long-exposure shot.
lead to camera shake and soft photos. Prevent this by choosing Live View  So refrain from touching the shutter button and, instead, opt for a cable
mode to eliminate mirror movement and ensure your images stay sharp. release or go into your camera's menu and set a two-second timer.
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CABLE RELEASE
Using a cable release
means you won't have
to wait for the two-
second timer to elapse
before each photo

Top tips for long exposures

Be aware of where you are placing

your tripod. For example, if you
are on a bridge, a passing car or
even people walking by can cause
vibrations that will blur your images.

Make sure that you have multiple

filters — even a 10-stop filter
might not be enough to slow your
shutter speed sufficiently.

If you have a UV filter on your

lens, remove it before you
attempt to screw in an ND filter or
the ND filter holder. If there is a slight

0 ﬁlswur

.+
U
)\ Y
Ml 2470mm LENS - ' o -
ol Normally with this type " £
}’. L™  of scenario, you need
M B awide-angle lens to

be able to fit the entire
scene into your frame

g &g
R ..

10-STOP ND FILTER
In bright conditions, using
a10-stop neutral density
filter is essential to allow
you to take long exposures

TRIPOD

A sturdy tripodis a must
for this type of long-
exposure photography
to avoid blurred photos

jam, it will be difficult to unscrew
the two filters from one another.

You also need to ensure that you
have enough power and spare
batteries for this type of photography.
Long-exposure photos will drain your

battery quicker than you think.

Be aware of colour casts when
using poor quality or cheap
filters, especially if they are made
from plastic. If you stack these,
you may find that your images have
a magenta colour cast.




SHOOTING SKILLS

Fix the shadows This was a high-contrast scene between the Add contrast Fixing the highlights and shadows has meant

bright, reflective stupa (shrine) and the shaded areas in the that the image now looks a little flat. The next step is to remedy
foreground. So the first thing to focus on is to brighten the shadows that on the Tone Curve by moving the sliders to create an S-curve.
and recover the highlights slightly to avoid them being clipped. | also added a bit more Clarity to define the edges of the objects.

T
e T
Tweak the brightness Boosting the contrast has darkened Zoom in and finesse At this stage, | zoom into my image to
the image slightly again, so | tweaked both the Brightness slider make some local adjustments and tweak things. For example,
and the Shadows slider to make it lighter. To make the colours pop increasing the brightness has resulted in some of the highlights
a little more, | also increased the Vibrancy and Saturation sliders. being clipped, so | created a mask and recovered these local areas.

Straighten and crop Next, | try to fix the converging lines in Tidy up My last step is to zoom into the image at 100 per cent

the image. In most cases, the image can be straightened by and check the photo for things like dust spots, which often become
selecting the Auto setting in the Transform tab. | then cropped in more noticeable when you darken clear sky areas. | use the Healing
slightly on either side and the top of the image to get a 4:3 ratio. function to remove these and clean up the rubbish in the foreground.
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Pictured

Quiet reflections

By using the long-exposure
technique, the movement of
people at this busy location

has been rendered invisible BEFORE

AFTER

Pictured

Silence is golden

After a few adjuschents to fix
the shadows and converging
lines, the final image'shows a
peaceful and uncluttered scene




Images © Natalia Zmyslowska @theworldwithnat

SHOOTING SKILLS

Capture nearby wildlife

Practise the core skills for a genre where a split second makes the difference

Wildlife photography is arguably one

of the medium'’s most challenging

genres. However, if you are thinking
of practising your wildlife shooting skills, you
needn't necessarily travel to far-off places.
Wildlife can be found in urban areas, even
on the streets of our biggest cities, where
foxes and deer often appear at night.

Wildlife parks or nature reserves also

provide opportunities to capture animals
closer to your home. In these better
controlled environments, you can observe a

. )
R
e

SCottish Owl Centre

Do your research Check that the park or

facility you are visiting follows an ethical
approach to conservation and identify the
species you're interested in photographing. For
action shots, consider visiting during feeding
times or scheduled enrichment activities.

1S0 speed
4 800

0 200 400 800 1600 3200 64
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Embrace higher I1SO If you are shooting
in low light with a fast shutter speed,
increase the ISO setting to maintain a proper
exposure. Modern cameras perform well with
higher settings but use the Denoise feature in
Lightroom to eliminate image noise, if needed.
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range of species and learn their behaviour,
characteristics and movements. Pay attention
to their feeding times, activity patterns and
preferred environments within the area.

If you decide to shoot in your local forest,
take advantage of the many helpful resources
available online, such as the RSPB website,
forums and apps, which provide detailed
information on identifying different species,
their habitats and migration patterns.

Timing is of the utmost importance in
wildlife photography, so have your camera set

Aperture

Small f/no Large f/no »
F4.0
4 X 8§ 1N

FERERRERE N

Shoot in M To capture the best images,

shoot in manual mode. Choosing an open
aperture when shooting through a fence will
eliminate the bars and let more light reach the
sensor. Bear in mind that an open aperture,
such as /4, will reduce the area of sharpness.

K

Drive mode

Shoot in burst mode When shooting
animals in motion, activate burst or
continuous shooting mode in your camera
menu. This way, the camera captures multiple
frames when holding down the shutter for
a little longer than you would usually do.

up and ready to go before you set off. Take the
time to familiarise yourself with your camera
and check the menu for any special features
that may help you shoot your best images.
For this shoot, we visited the Scottish Owl
Centre in Polkemmet Country Park, near
Bathgate. The centre is home to over 140 owls
from 50 species and offers indoor photo shoot
sessions and workshops with expert tuition
from pro Dean Bricknell. In this tutorial, we'll
explain the steps you need to conquer limited
lighting, make fences disappear and more.

_ Shutter speed

< [Slow Fast »

1/320
30 60 125 250 500 1000 2000 40(

Ensure sharp results Shutter speed
settings vary depending on the subject
— the faster the animal, the faster the
speed. Start with 1/250sec for moderately
fast-moving subjects and to nail the focus,
deactivate AF and activate the eye detection.

—77 100-1787

I

Analyse frame When waiting for the

subject to appear, use any spare time to
look at your photos and analyse them in detail.
It's a great opportunity to discover patterns,
leading lines and angles that could enhance
your composition for the next set of frames.



Inset
Hidden details

The image has distracting
elements blocking the owl,
while the exposure and focus
settings aren't perfect either

VE ]

Easy prey

By shooting through the
fence, using appropriate
camerasettings, the owlis
showcased infull detail, with
all its colour and texture
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EDITING SKILLS: PHOTOSHOP

PHOTOSHOP
TUTORIAL

Meet the editing pro

James Abbott is a
professional photographer
and photography journalist
specialising in shooting and
editing techniques. His first
book was recently released
and covers professional image editing skills
in both Adobe Photoshop and Affinity Photo.
@jamesaphoto jamesaphoto.co.uk

Open Depth Blur Open your image

in Photoshop and go to Filter > Neural
Filters > Depth Blur. If you've never used the
filter before, click on the download button.
Once that's done, activate the Filter and the
dialogue opens with default settings applied,
creating a crude shallow depth-of-field effect.

Brightness and Grain At this stage, you

can adjust the Brightness but the more
important setting is Grain. The blurring effect
can smooth out the natural grain in these
areas, and this can be restored by zooming
into the image and increasing the slider. This

image was set to +10 Brightness and 50 Grain.
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Create differential
focus using Depth Blur

Take advantage of Photoshop's Al tools
to apply a shallow depth-of-field effect

A‘? There are many occasions where
%’ 4 you may want to capture a shallow
W depth-of-field for creative purposes

but were unable to for technical reasons. This

could be because you required a specific
shutter speed or something else. Either way,
all isn't lost because Photoshop's Depth Blur
Neural Filter allows you to achieve shallow
depth-of-field effects quickly and easily.

Set the point of focus You can either

left-click on the image thumbnail, use
the Focal Distance slider or check the Select
subject box to set the point of focus. Of the
three, left-clicking on the image thumbnail is
the most precise. Next, set the Blur Strength
to the desired amount - 70 was used here.

Set the Output Next, once you're happy
with the overall result, set the Output
option. This can be set to Current Layer, New

Layer, New Layer Masked, Smart Filter and
New Document. The option selected here
was New Layer to maintain a non-destructive
workflow, although all options have merits.

What you'll
be using

® Depth Blur Neural Filter

@ Focal Point/Focal Distance
® Focal Range

@ Blur Strength

@ Haze

Set Focal range Now, with the desired

amount of blur, drag the Focal range slider
to the right to increase the depth of sharpness
until you're happy with the result. You can also
increase Haze, which is stronger in the blurred
areas if you would like to mimic wide aperture
haziness. For this image, Haze was set to 20.

KEY TIP

DON'T GET BOGGED DOWN

BY UNNECESSARY TOOLS

The Depth Blur Neural Filter provides

all the tools you need to be able to create
a convincing shallow depth-of-field effect,
including white balance Temp and Tint
controls. However, for the majority of
images, these won't be necessary.

Insert Main
Large depth-of-field Greater depth
To help achieve the slow The Depth Blur Neural

shutter speed required
toblurthe subject motion,
this image neededtobe
shot at f/11, which resulted
inalarge depth-of-field

Filter has done a great job

of reducing depth-of-field,
creating agreater sense of
depthinthe scene withmore
focus on the point of interest
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EDITING SKILLS: LIGHTROOM

LIGHTROOM
TUTORIAL

No tilt-shift lens, no problem thanks to Transform

A‘ Tilt-shift lenses, also known as

q perspective control lenses, are
specialist optics typically used in

architecture and cityscape photography. They

use a shift mechanism to avoid converging

Process the Raw file Process your image

as usual, using the Basic controls and the
Tone Curve to add contrast. Complete the
image processing as much as possible, but
you can return to these settings later if you
need to make further adjustments once the
perspective correction has been applied.
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Crop the image You can check the
Constrain Crop box for Lightroom
to automatically crop the image, but this
removes your control of the process. Instead,

use the Crop Tool below the Histogram to crop

the image manually so you can decide how
the composition looks and how much to crop.
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verticals when shooting tall buildings.
However, they are so expensive that many
photographers can't justify buying one. The
good news is that you can achieve excellent
perspective correction tools in Lightroom.

Use Guided Transform Scroll down to

the Transform tab and click on Guided.
Left-click on a converging vertical line tilting
inwards at the top, keep the button held down
and use the guide to place the second point
when you release the button. Repeat for the
right side and the image will correct itself.

Double-check adjustments Now the

image is straightened, decide whether
you need to make further adjustments in the
Basic tab. For this image, we reduced the
Temp from 5200 to 5100 to remove a hint of
yellow and the Exposure was increased from
+0.97 to +1.10 to brighten the image slightly.

. Correct perspective

distortion

What you'll be using

@ Basic adjustments
@ Tone Curve

@ Transform

@ Guided controls

@ Crop Tool

Apply manual controls You may still

need to apply further adjustments, so use
the sliders in the Transform tab. This image
still needed to be rotated slightly and there
was a small amount of horizontal distortion
where the camera wasn't aimed directly at
the subject, so we also set Horizontal to -3.

KEY TIP

SHOOT FOR TRANSFORM
At the point of shooting, if you think you
may need to use the Transform controls

to remove perspective distortion, shoot
wider than you would normally to
accommodate the amount of cropping
that will inevitably be required.

Insert Main
Converging verticals  Final crop
This photograph was taken Usingthe Transform controls

onsoftdry sandsothe
horizonisn't quite straight
andthetilt ofthe camera
has resultedin converging
verticals onthe beach huts

will result in some degree of
cropping totheimage. Apply
thetools then decide whether
theimagelooks better with
orwithout the distortion
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EDITING SKILLS: AFFINITY

AFFINITY
TUTORIAL

Add dramato
your portraits

Frame your portrait to make the subject stand out

Monochrome portraits are a great

way to highlight the eyes and facial

features of your subject. By editing
the background to black and blending the

subject’s outlines in one frame, you can create

a negative space that allows the subject

to stand out, while effectively drawing the
viewer's attention to the frame. With this
technique, your portraits will look as though
they were shot in a high-end studio.

What you'll be using

@ Curve Adjustment Layer

@ Pixel layers
@ Brush tool
@ Colour Panel

@ Blend Ranges option

Add drama Firstly, work on the overall
contrast of the image. Add a Curve
Adjustment layer and make the line into an
S-curve by adding nodes and dragging the line
to bring the highlights up and the shadows
down. The layer works non-destructively,
so you can fine-tune the settings at the end.

Allimages © Rachel Claire

Add a mood To create a moody look,
adjust the darker areas by adding another
Curve Adjustment layer. Select the bottom
left node and gradually increase its position.
This step is optional and depends on personal
preferences, so experiment with the settings
until you achieve the desired result.
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Colour in the background Add a Pixel

layer. Select the Paintbrush tool with
100% flow, opacity and 0% hardness. Choose
black from the colour wheel. Paint around the
subject, avoiding the outlines. Add another Pixel
layer. Select the Brush tool with 20% flow and
use it to fill in the gaps. Correct with the Eraser.

Fine-tune Add another Curve Adjustment

layer and bring the middle node of the
graph right down. Now invert the layer and
drag and drop it to the right of the background
layer. Finally, use the Brush tool to paint over
any elements you want to darken with a white
colour or brighten by painting with black.

Blend outlines Add a third Pixel layer.

Use the Paintbrush tool to paint over the
outline of your subject. It doesn't need to look
perfect, as we will blend it in. Open the Blend
Ranges option and focus on the right graph.

Lower the right node and move it to the left to
recover any overpainted highlights and details.

KEY TIP
EXTEND THE FRAME

If your portrait only has a little background

space around the subject, extend the

frame by selecting the Crop tool and
adjusting it to your preferences. You can
apply the editing technique to a variety
of portrait shots so that your subjects
stand out for a more professional look.

Insert

Cluttered background
Theimage elementsinthe
background distract the viewer
sothat the focus is no longer
exclusively on the subject,
resulting ina lack of contrast
and overlooked details

Main

Monochrome drama
Using the Layer tools and
Blend modes in Affinity Photo
2.0, we have added some
dramaand enhanced

the contrast, making the
subject stand out visually
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Issue

What's inside: Get the

most from your camera

kit by applying our secret
steps to improving image
quality. Next, learn to shoot
incredible street scenes,
capture panoramas and read
our Canon EOS R3 vs Nikon
Z 9 head-to-head test.

youneed tolearn

{sTasr 6106 |
SHOW THE WORLD
YOUR PHOTOS

Issue

What's inside: With exclusive
advice from the winners of
the Photographer of The
Year competition, discover
the essential techniques you
need to know right now. We
also round up the best kit of
2023 in our annual Gear Of
The Year Awards feature.

Issue

What'’s inside: Shoot golden-
hour colours in our dazzling
sunset landscape Creative
Project, capture wildlife shots
in challenging conditions
and, in our main feature, you
can dive into our complete
10-page guide to landscape
photography composition.

©Camerassttings o Top level

techniques o Refouching

fcer oo
SHOOT CITIES
ATNIGHT

Foccoe oo I

[csscnmia sovice]
EDITING DIVERSIFY YOUR
PHOTO BUSINESS

Issue

What’s inside: Portrait
photography needn't be
complex. Find out how to
capture top-tier images with
ease. Plus, we have a special
feature on becoming a photo-
editing maestro, a cityscape
shooting tutorial and a full
review of the Lumix GO II.

START SELLING YOUR PHOTOS!

dvico tooarn exira ncom

gt

Issue

What's inside: Filters still
have a place in the landscape
photographer’s kitbag, so we
cover the ones you should
own and how to use them.

In our regular Shoot Likea
Pro feature, we shadow a
photographer on a magazine
editorial shoot for key tips.

 CASH FROM YOUR CAMERA! &
Essentiol pmswul advics for photosthat

Issue

What'’s inside: Autumnisa
popular time for landscape
photography. Our cover
feature explores how best

to capture this colourful
season. If you love black and
white photography, don't
miss our tutorial on shooting

and editing film-noire scenes.

DREAM PHOTO CAREER!

Issue

What'’s inside: Demystify
video in our behind-the-
scenes guide to working as
apro videographer. Get the
best quality from your RAW
files, both at the shooting
and processing stages.
Shoot amazing architectural
images with our pro advice.

NIKON Z 8: THE CANON KILLER? ¢
WE PUTTHE ULTIMATE D850 REPLACEMENT ON TEST |

e
CASH FROM
ot ehmEn

Issue

What's inside: Read

Ross Hoddinott's top tips

for mesmerising macro
photography. We also review
the awesome NikonZ 8
full-frame mirrorless camera
to see whether it takes the
crown as the best model in
its class and price bracket.

DREAM PHOTO CAREER'

you sterted a5 3 pro

Issue

What's inside: Astro photos
can inspire like no other
genre. Find out how to shoot
nightscapes like a pro. Delve
into our career advice pages
to learn how to take your first
steps towards your dream
photo job. Plus, shoot and
edit summer landscapes.

Vo wih g  ramaticconast
Controtdeta

oW
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Issue

What's inside: As part of our
ongoing Masterclass series,
seasoned pro photographer,
Jeremy Flint explains how to
master exposure. We also
round up the best photo-
editing apps today and
explain how to get incredible
shots from your smartphone.

| croPp- SENSOR LENSES (iliey

PHOTO PROJECTS

fcreaTive sk <)

Issue

What's inside: Shoot great
images at the most popular
times of day — sunrise and
sunset. Go behind the
scenes with a luxury car
photographer. Learn how to
capture impossible macro
photos and shoot emotive
weddings like an expert.

AFFORDABLE MIRRORLESS

Great vaiue smaller-sensor cameras reviewed

[oreamve cs

SURREALNIGHT
[ G|

Issue

What'’s inside: Who doesn't
love shooting at the coast?
Overcome the challenges of
capturing stunning seaside
masterpieces. And, if you
think you know your camera,
think again! Read our hidden
camera features guide and
get the most from your gear.

DREAM CAMERAIPAN ONIC I
Ias Lurni e best video-sulls hybrd iodel aroud?

ONEY FROM
YOUR PHO”TOS |

Issue

What'’s inside: Master the
art of fine black and white
photography with expert

Kav Dadfar. In our career
guide, learn how to widen the
audience for your photos and
discover the latest features
you will need when buying
your next telephoto lens.

FUJIFILM X-T5: RETRO POWER!
Aclassic design meets modem APS-C tech magic

‘cRAFT
TECHNIQUES

Issue

What’s inside: You don't
have to travel far to capture
stunning wildlife — read
how in our urban wildlife
cover feature. Also, capture
cinematic landscapes and
check our reviews of the
Fujifilm X-T5 and monster
Nikon Z 600mm f/4 lens.
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Is this Can

REME:
LANDSCAPES
e O

HIRE A STUDIO
FORLESS
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Spen shectan

Issue

What's inside: Everyone
loves pet photography and
we're on-hand with insight
into running a smooth shoot
with your furry companions.
We also have a hands-on
review of the amazing Canon
EOS R6 Mark Il full-frame
mirrorless camera.
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GOPRO

SWITCHING

CAMERA
SYSTEMS

Stick or twist? Dan Mold assess the options when
it comes to staying loyal to your camera brand,
switching over or straddling multiple systems

Over the years, I've owned cameras
from pretty much all the big camera
manufacturers, switching between
systems to find one with the right ergonomics
and menu systems that make sense to me,
all whilst weighing up the range of lenses
available, portability and, of course, the price.
No doubt you've faced a similar conundrum
— stick with the system you're used to or switch
to arival brand. There are many reasons to
switch systems and even justifications for
shooting on multiple brands at the same time,
whether that's using a portable Micro Four
Thirds camera for travels and holidays and a
DSLR or mirrorless full-frame body for better
detail in a studio, as just one example.
If you shot in the days of film, this probably
isn't your first rodeo, as you'll have likely made

the switch from your film SLRs to modern
digital DSLRs in the early 2000s. A similar
turning point is happening again with the
latest mirrorless camera technology, as
pretty much all new cameras and lenses
released now are of the mirrorless variety.

If you have a camera with a cropped sensor,
such as Micro Four Thirds or APS-C, and your
current system doesn't meet expectations,
this could be a convenient time to make the
switch. If you've always dreamed of upgrading
to a full-frame body, you may have to cash in
all of your equipment as your kit won't work
properly on a larger full-frame body.

In this feature, we'll look at the benefits and
drawbacks of shooting on multiple systems
and assess whether switching or upgrading
your camera kit is the correct thing to do.

Catch up on our career features

START YOUR

PHOTO

ISSUE 275: START
YOUR PHOTO BLOG

ISSUE 276: BUYING
™4 == SECOND-HAND

GET YOUR BACK COPIES HERE: HTTPS://BIT.LY/DPBACKISSUES
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SWITCHING CAMERA SYSTEMS




Using dual systems

There are various reasons for shooting

on multiple interchangeable lens camera
systems, whether you're in the process of
switching from one to another or you have
to separate systems to cater for different
jobs. Maybe you have a small and portable

Look for gaps in lens ranges

You can guarantee that all the big manufacturers will have iterations
of the most common lens models, such as /2.8 versions of 16-35mm,
24-70mm and 70-200mm lenses for their full-frame mounts. But it's
worth looking at any specialist lenses you may wish to purchase later,
as there could be gaps in the range that make you regret your choice.

For example, Nikon makes a 20mm /1.8G lens, which is fantastic
for astrophotography, however, there isn't an equivalent lens for

Canon photographers
in EF or RF mount.
Canon is the only
manufacturer to
currently have
a100-300mm
f/2.8 lens in its
arsenal, although
Sony has a much
larger offering of
third-party lenses
for its mirrorless
full-frame E mount.
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Micro Four Thirds or APS-C system

that is less conspicuous when shooting
street and travel photography and a
larger full-frame mirrorless or DSLR for
shoots where you need more pro features
and resolution or for enhanced video

P

“i6

@
=
=€
oS
o
[
2
=
=

RS

S

Third-party options
Sony was the first company to
produce a full-frame mirrorless
camera back in 2013, while Canon
and Nikon didn't launch their
respective full-frame mirrorless
iterations until 2018.

This puts Sony at an advantage
as it has had an extra five years
to build up its lens range. It has
also opened up its E-mount to
third parties, so optical offerings
from the likes of Sigma, Tamron
and Samyang are plentiful. In
comparison, Canon and Nikon are
yet to fully open up their mirrorless
mounts to third parties, so the
range of lenses can feel limited,
which is worth taking into account.

capabilities. There’s often a cost aspect to
this as, if you have the budget, you could
get a camera such as the Canon EOS R5,
which can do everything from 45MP stills
to 8K video all in one model - the catch
is that it costs £4,000 just for the body.

-
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SWITCHING CAMERA SYSTEMS

Cash in your DSLRs and go mirrorless

Unfortunately, not all adapters are made equal, and proprietary first-party adapters to
convert full-frame DSLR lenses to the newer full-frame mirrorless mounts can be a great
idea, helping you save money by using your old DSLR lenses. It's no secret that many new
mirrorless lenses are extremely pricey, so it can make economic sense to hang on to

your DSLR lenses, using an adapter to make them compatible with your new mirrorless
camera from the same manufacturer. Canon has various adapters to convert its full-frame
DSLR EF lenses to the new RF mount, with some adapters having built-in ND filters or
drop-in filter options. As these adapters are first-party, it means the exposure settings

can all still be set in-camera and the autofocus continues to work well too.

© Dan Mold

Avoid cross-party converters
There are adapters out there to allow lenses
from one brand to fit another manufacturer’s
camera body, such as Nikon to Canon, Fujifilm
to Sony and so on. But while these may do

a reasonable job, we've never had a good
experience with them. The manufacturers
would much rather you buy their own
proprietary optics, which will deliver the
smoothest operation. Many of these adapters
also forego any electrical communication so
dialling in camera settings and focus becomes
a manual affair — that's not the end of the
world but for a better experience, we wouldn't
recommend crossing your mounts. On the
other hand, using third-party glass intended
for the mount it was made for is fine.

© Hiya Images/Corbis/VCG via Getty Images

Personal preference

It's important to try out a camera before you part with your cash, so visit a camera
shop, borrow a friend’s camera or rent one from a site such as hireacamera.com so
that you can get your hands on one and give it a proper test. You'd be hard-pressed
to find a modern digital camera that won't take a decent image, instead, the main

differences between makes are often found in the ergonomics of the camera grip,
layout of the buttons and features such as frame rate or video options and the user
interface. Try out a few different cameras to find which model you prefer to shoot with
as you're less likely to pick up your camera if you find it difficult to operate. There may
be specific features, colour and design choices that sway you one way or the other.
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Kuzma Vostrikov

Location: New York City, USA

Specialisms

@ Contemporary @ Portraiture

To see more of Kuzma'’s work: (6 @kuzmacinema

Filmmaker and visual artist Kuzma Vostrikov's work reflects diverse interests, including the
role of technology in contemporary society, psychology and history. The artist’s work is found
in international collections, including the CICA Museum in Korea, The Yokyung Art Museum,
Korea and The Museum of Russian Art in New Jersey, USA. He recently released a new book,
Just To Land In Tokyo, with his collaborative partner, Ajuan Song (see Photo CV, next month).

JTLIT (Just To Land In Tokyo) 2
Kuzma is a self-described multi-disciplinary artist
who works to blend photography with other art forms

JTLIT 25
Much of Kuzma's imagery is often abstract and
conceptual in nature, questioning the very nature of art

JTLIT1
Kuzma collaborated with his long-time artistic partner
Ajuan Song on the Just To Land In Tokyo book project
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Career Path

When did you start out in

your current photo genres?

It would be accurate to say that I've been
handling everything that captures movies
and photos since before school: that

was my path to the genre. My eyes were
preparing to become accomplices in
interpreting visual reality. In the 1970s, my
parents formed an underground art group
called Synthesis and | was involuntarily

a participant in the artistic process, helping
to shoot on 35mm film. | understood the
aspects of camera work but the technical
side is not the most important. You can shoot
with a matchbox or an ironing board. The
main thing is the thirst for exploration.

You describe yourself as a multidisciplinary
artist. How do you bring all of your artistic
interests together for a project?

It's hard to work in just one narrow genre.

Left

Absolutely
Augmented Reality
This image was part of
alarger photographic
project now set to appear
in documentary format

Below-

JTLTS

Kuzma'’s parents were
underground artists in
the 1970s, influencing
his career path and
current expressive style
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| want to take a risk with the unknown,

not to make everything by the rules but to
combine different interests and techniques

in one project. It's not that difficult, after

all, an idea can be expressed in various

forms and languages. Even in the abstract
form of supersonic aeroplanes, laid out in a
mosaic across the entire territory of Australia.
Or a love confession, engraved under a
microscope on the eye of a needle. After all,
some people stick bananas to walls with tape.

What are your future plans? Are there any
other genres you'd like to expand into?

In the near future, we plan to show

the documentary-fiction, full feature

film ‘Absolutely Augmented Reality, an
autobiographical picture about a namesake
photo project of a hundred works that we
completed in 2018. Work on the film has
recently been finished, you can watch the

x6 © Kuzma Vostrikov

PHOTO CV

Kuzma’s photo kit

The essential gear items used
forthis type of professional work

HASSELBLAD H2
FILM CAMERA

=, Aclassic analogue
setup for arange of
artistic tasks in-studio
and outdoors. It has
an autofocus system,
which is crucial for
certain situations.

HASSELBLAD HC
80MM LENS

A standard MF lens
for the H2, equivalent
to the classic 50mm
in 35mm format.
Autofocus is effective
at smaller apertures
and it delivers a shot
with notable plasticity.

SONY A7l

A classic camera
body well-regarded
for various tasks. One
of its advantages is
its capability for both
photography and
video recording.

ZEISS COMPACT
PRIME CP.2 35MM
T1.5 + ADAPTER
FOR SONY
Designed for
cinematography, this
lens has an aperture
of T/1.5, enabling low-
light performance and
beautiful bokeh. For
closeups, consider the
85mm T/2.1too.

trailer at absolutelyaugmentedreality.com.
Perhaps the next project will be a new art
film. As for other genres, we would like to
try to mix photography and the plasticity
of painting at a new level. There is also
enough material for a new photo album.

How do you balance personal vision
and commercial appeal in your work?
Good question. | have an answer for you.
Art cannot be ‘commercial’; that's an
oxymoron. A true idea maintains its virginity
and has no price. The more commercial, the
more dead-end. We're not going to call work
that is done to order for corporations - in the
broad sense of the word — ‘art) are we?
Muriel Roberta Latow advised Andy Warhol
to draw money. We all draw money from time
to time. Some with pride, others with a sense
of shame. If you're a guy who loves money,
you should be polite to the mainstream!
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All work and no pay

| feel like I'm working hard
but only bringing in a minimal
amount of money. | love the
photography side of my job
but I'm not business minded
at all - | struggle to keep up
with my admin and have no
idea how to approach clients
to get more regular work.

Do you have any advice?
Anonymous

It sounds like you could do
with getting some help from
an external source. There are
many ways you could do this
from employing someone to
run the admin/marketing side
of your business (although if

Suitcase query

| need a roller bag for my
corporate and commercial
photography work. | travel

a lot and mostly work in an
urban environment. Do you
have any recommendations?
Jenny Henderson

The Manfrotto Advanced
Rolling Bag Ill is a solid
choice and is available from
retailers such as WEX for
£199. This suitcase has
a hard exterior layer
for protection
and fits one
or two camera
bodies, five or
six lenses and a
15in laptop. It also meets
airport carry-on luggage size
restrictions, which is a bonus. If
you have a bigger budget, the
Manfrotto Reloader Switch-55 PL
Roller Backpack is also worth a
look at £299. This roller can also
be used as a backpack, making

§ it a more versatile piece of kit.

£ Again, it fits international carry-on

6 luggage size and can carry up to
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you're only earning a minimal
amount of money, this won't be
viable at the moment) to getting
help from a business coach like
Marisa Guthrie (see interview,
next page). Often, we cannot
see what we are doing wrong as
we get so emotionally involved
with our work that we need a

fresh set of eyes on the problem.

Being a self-employed
photographer is a challenging
job. One half of the job is
photography but the other is
more complex and requires a
multiple skill set — don't be hard
on yourself if it doesn't all come
naturally. Getting help elsewhere
is the best place to begin.

two cameras
and four or
five lenses. If

you're on a tighter budget, the
Calumet RM2197 Airport Roller
Bag is £109 and can hold two
cameras and two or three lenses
plus an integrated 13in laptop
compartment so is worth a look.

The Manfrotto Reloader Switch-55
PL Roller Backpack can hold lots of
camera gear and is fully protective

Career advice

‘ This month, Claire Gillo explains how getting advice from
a business coach can help you turn things around quickly

Getting help from an external source is usually an excellent way to take
back control of the way you work and start growing your business

Frozen fingers

My aim this year is to spend
more time outside taking
photographs for my landscape
portfolio but | struggle to keep
my hands warm. What do other
landscape photographers do to
stay warm?

Carol Jones

It's always the hands that go
first, then the feet! Keeping your
extremities warm is key to being
comfortable in the field — staying
that bit longer could be the
difference between getting a
winning shot and not - so
you need to invest in
some good gloves.
The Pgytech
Photography Gloves
are a good place
to start. They're
waterproof and triple-
insulated and have a
removable finger part,
S0 you can work your
camera with them on.
Costing just £39, they
are a solid choice
if you're on a budget.

Another option is the Vallerret
Hatchet Photography Glove.
These come with a luxurious
merino wool liner and a goat
leather exterior. Again, they have
flip-open tips on the thumb and
forefinger so you can control your
camera but, at £97, they are more
expensive. Finally, the Swarovski
GP Gloves Pro cost £66 and
they feature a leather-reinforced
neoprene material that is water-
repellent and wind-proof. The
index and middle fingertips are
touchscreen-compatible as well.

Also, take a bottle or
flask of warm water
(make sure it's not
boiling) to pour over
your hands when
they get cold. A
small towel to dry
them as well is
essential. This

is a real game-

changer!

The Vallerret Hatchet gloves
could be a game changer for
landscape photographers

© Claire Gillo
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Get external help

with your photography

business by using a ——
small business coach

such as Marisa Guthrie

How do | make my business work?

Small and micro business coach Marisa Guthrie explains how she can
help small photography businesses grow and become more profitable

Hi Marisa, tell us

a bit about yourself...
I'm a business coach to
small and micro businesses.
One way or another, | have
been running businesses
for nearly 28 years across
many industries and sectors. Since setting up
my coaching business in 2008, | have worked
with hundreds of business owners, many of
whom are artists, creators and makers.

What is a business coach and
how do you help your clients?
Crucially, I am not a consultant, so | don't tell
people what to do! As a coach, | believe that
you already have answers to the issues you
are grappling with. My role is to facilitate you
being able to find those answers. That doesn't
mean | don't hold my clients accountable.

| spend a lot of time getting to know you
and your business, and together we create
a strategy and a plan for your business. My job
is to hold you accountable to that plan so that
you move closer to your goals. Working in this
way means my clients see the changes they
wish to see because they have bought into the
whole process. It's hugely satisfying and such
a privilege to be invited to be a part of that.

Why do you choose to work with
small and micro businesses?
The majority of business activity in the UK

comes from small and micro businesses,
(typically one-person enterprises or up to

10 employees) with some estimates quoting
as much as 80 per cent of overall businesses.
That's a huge amount!

But because they are usually self-funded,
have limited budgets and little infrastructure,
these businesses are the least able to access
any specialist kind of support, such as working
with a business coach. I'm using my skills
to address that inequality and level up the
playing field for these hard-working business
owners.

For any pro photographers or aspiring
photographers out there who are
reading this, what services would you
offer and how could you help them?
For every kind of business imaginable, there is
a business coach, and we all do things slightly
differently. The work | do focuses specifically
on helping people create profitable businesses
that they love running. This might sound
obvious, but we're all aware of those ‘get to
six figures in six months’ type of coaches.
While that kind of growth is possible, it isn't
likely because what those coaches don't tell
you is that you will need to work 80+ hours
a week to get there and, if you do that, you'll
be burnt out and hate your job.

What | am interested in is helping people
create fulfilling and sustainable businesses.
Businesses that facilitate the owner’s personal

goals and bring them joy, while being of
service to others. That's why my strapline is

“Increase your profits, do more of what you

love!" If you build a profitable business that
you don't enjoy working in, it won't be fulfilling.
Equally, if you love what you do, but you aren’t
making enough money to support the life you
want, it's not sustainable.

Through providing sustainable growth
programmes, | help business owners create
the businesses they want. To show them
specifically how | do that, | offer a free
two-hour business review so we can really
explore exactly how | can help them and they
can leave with actions they can take and
implement straight away.

Are there common mistakes that micro
business owners, such as photographers
make and what advice do you give them?
Confusing sales and marketing is something
nearly all business owners struggle with.
Often, there is a big emphasis on marketing,
but there is no strategy around any kind of
sales process, so it is left to chance with an

‘I | build it, they will come’ kind of mentality.

Of course, we need good marketing to get
people to our business, but if we don't know
what to do with them when they get there,
we won't see our businesses grow. Luckily,
this is something | can help with. None of
this is rocket science, just something that
requires a bit of time and strategy.

To find out more about Marisa Guthrie, visit marisaguthriecoaching.co.uk, or follow on Instagram @marisaguthriecoaching and Linkedln @Marisa Guthrie
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" ‘When capturing wildlife, you should N
always respect your subjects and give ST -
them plenty of space. This ensures & 5_ :
~ safety for both you and the animal and e S
~ also allows you to capture more natural —

behaviour. “| frequently capture the

Great Blue Heron, due to its common

presence in our region,” says Shaun.
“They are quite comfortable around —
humans, so | find it a valuable chance
to refine my skills while respecting its
space,” he adds. Shaun believes that :
capturing an animal’s natural behaviour {
is important. “Photography plays i \ / . @
a vital role in raising awareness about ‘J )/ N
conservation issues. By capturing: ”' 1%
compelling images that resonate 7 =~ ©
with viewers, you foster empathy = ¢
and understanding for threatened ;ﬁ

Low perspective ) ;
“Shooting from a low perspective, such i
as the animal’s eye level, is fundamental.
This approach enables viewers to connect
with the subject, creating a more intimate

portrayal,” says Shaun. He aims to

perspective, while also raising awareness
of conservation issues. By creating these
visual connections, Shaun’s images -
serve as a powerful tool for advocacy,
mobilising action to protect biodiversity
and natural habitats — this approach
earned Shaun an honourable mention
in Canadian Geographic’s Wildlife in
Action contest in 2023. “In today’s
world, where environmental challenges
are increasingly urgent, conservation
photography that connects with the
viewer inspires stewardship and drives e
]
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positive change for our planet’s future.”
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Sharp details
Freezing rapid motion, such as the bird diving into the
river, requires a keen eye for detail and a mastery of the

& exposure settings. “I typically aim for the sweet spot
between /8 and /10 and, depending on the available
light, | adjust the ISO accordingly,” Shaun explains. “With
these settings and some adjustments to the shadows

2 . | ‘and highlights in post-processing, | was able to capture
the scene as I'd hoped.” For this dynamic close-up shot,
Shaun used the R7’s animal tracking feature. “I've honed

‘my skills in approaching wildlife discreetly and anticipating

. z the decisive moment. And as soon as the Great Blue Heron

signalled its intent to strike, | was ready,” he says: e ‘,
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Splashdown

Mirrored elements
Reflections create mirrored elements that add %
an extra layer of depth and complexity and

create dynamic compositions. “During my

shoots, | actively seek out reflections,” says
Shaun. “In this instance, the conditions were

ideal — calm waters, warm air and minimal

wind - and the reflection you see is straight out
of the camera; no filters were applied,” he says.

In post-production, Shaun cropped the image

and made clarity adjustments to emphasise the
bird’s eye within the water splash. “My goal was
to maintain authenticity by adding or removing

as few elements as possible, ensuring that the
image stayed true to its original capture while
also enhancing its focal point,” he adds.

Date: July 2023

Kit: ® Canon EOS R7

@ Canon RF 100-500mm
f/4.5-71L ISUSM

@ Focal length: 324mm

“Capturing moments, creating memories
- never give up on chasing your dreams!”

Shaun Antle

Shaun Antle, also

known as ‘Oh Me

Nerves Photography’,

hails from Ontario

in Canada but calls

the Newfoundland
region his ‘true home'. Since taking
up photography in the early 2000s,
Shaun has undertaken many journeys
across the globe but it has also had
a profound impact on his life, serving
as a therapeutic outlet for managing
anxiety and depression. Shaun's eye
for a great image has been recognised
by several professional organisations,
including the International
Photography Awards 2023, where
he received an honourable mention,
and Canadian Geographic magazine,
reaching the final of its Photographer
of the Year contest in 2023.
ohmenervesphotography.ca
@oh.me.nerves_photography
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INTERVIEW

THROUGH
THE LENS OF

PlLVYAS

With some special effects and a vivid imagination, Mitchel Wu brings
toy figures to life, revealing a different side to these iconic characters

Words by: Kim Bunermann
All images © Mitchel Wu

Pictured

Weekend Warriors
General Grievous enjoys
abeer or four as the
Stormtroopers take
control of the barbecue
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MITCHEL WU

Pictured

The Clawwww
These aliens appear
to be transfixed by
adifferent clawto the
one in the Pizza Planet
vending machine




“Ultimately, the questior

1S, in'your photography
career, do you want to be
a commodity or do you

- want to be an asset? Do
you want to survive or
do you want to thrive:

»



e low perspective adds
dynamism to the shot,
while the flying sand and
stones create a visually
striking effect to indicate
the movement of the car

MITCHEL WU

hen preparing for
this interview, the
discussion at the
Digital Photographer
office inevitably
turned to the cartoon
characters that
inspired us when we
were young. Whatever their background, it's
a topic that connects people and, despite
growing up on the other side of the World,
Mitchel Wu's work features many of the
characters that influenced our childhoods.

As we spoke to the Los Angeles-based Wu
by video call, the toy figures sitting on shelves
in the background reminded us of the movie
Toy Story, with Wu resembling the human
main character, Andy. However, whereas Andy
is an ordinary kid who plays with his toys until
they come to life when he leaves the room,
Wu is the one bringing the toys’ characters
to life. “As | work, | find myself in the same
thought process | had as a child when | played
with toys — weaving stories and pushing
forward," he says. “I'm rediscovering the joy,
reconnecting with my 10-year-old self, while
enjoying the creative freedom of writing my
own stories — that's what drives me.”

Wu has a unique approach to storytelling.
Using a range of toys, props and special
effects, he tells an alternative story of the
characters, often with an added sense of
humour. Here, he explains how he creates
these miniature worlds around the figures
and how he carved out a career in this field.

Mitchel Wu is a Los
Angeles-based toy
photographer who
crafts scenes using
toy figures and special
== effects to create
% an illusion. He has
‘ W worked with some of
the biggest names in the entertainment
industry, including Disney, Marvel, Warner
Bros and Nickelodeon. Wu's self-taught
craft allows him to capture the nostalgia
of iconic film and cartoon franchises,
such as Toy Story, Star Wars and
Rocky, with precision and creativity. He
is committed to providing unparalleled
experience for his clients while creating
images that build brand awareness in a
fun, engaging manner. Wu also shares his
knowledge with others and his work has
been featured on Disney Plus, PBS SoCal,
The Pop Insider magazine and PetaPixel.
mitchelwutoyphotography.com
@mitchelwuphotography
(=) @MitchelWuToyPhotography



INTERVIEW

Hey Mitchel, tell us how you got

into shooting toy characters?

I've worked in creative careers for most of my
life. The best ‘job’ | ever had was with the Walt
Disney Company, where | managed product
design and development for their collectables
division. | worked there for six years but
eventually left because | grew tired of working
with the same characters day in and day out.
This was a recurring theme throughout my
career. Regardless of which company | was
with, | would eventually reach a point where

| began feeling bored. | considered myself

a restless creative before picking up a camera
and pursuing photography as a career.

Being self-employed as a toy photographer
has been a revelation. With so many
characters and figures to work with, the
only real limit is my imagination. | can create
stories around established comic, cartoon and
movie characters that don't adhere to existing
narratives. This almost unlimited potential for
creativity is what | love about image-making
and storytelling through toy photography.
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Pictured

Skyscraper Capers
Popeye is one of Wu's
favourite cartoon
characters, so every
element of this scene was
crafted to bring itto life
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With an almost unlimited potential for
creativity, do you have to be mindful of
anything in terms of creative freedom?
When I'm working with a client, there are
always certain parameters that need to be
followed. On the other hand, when I'm creating
work for myself, the sky's the limit. The
possibilities are endless, especially as | can
combine characters from different properties
and universes, what | call a mashup. There's
so much creative freedom that, if I'm not
careful, | could easily push it too far. It's a lot
of fun but it's important to know where to
draw the line, or at least when to cross that
line with conviction and intent.

Many people have childhood cartoon
heroes, who was your favourite character?
One of my favourite cartoon characters

was Popeye. | grew up watching Popeye

and still joke that the spinach industry was
secretly behind his popularity. Am | the only
one suspicious that so many kids became
spinach eaters and fans by watching Popeye

cartoons? Ridiculous conspiracy theories
aside, | also watched a lot of Warner Brothers’
Looney Tunes cartoons, such as The Road
Runner Show and Bugs Bunny. The cartoons
| watched as a kid during the 60s and 70s
influenced my creativity and the properties

| now gravitate towards. What influences you
when growing up almost always ends up
influencing you as a toy photographer. Those
who grew up in the 80s and 90s, for example,
tend to shoot a lot of Star Wars, Marvel and
Teenage Mutant Ninja Turtles.

Besides my own nostalgia, another
significant influence is the characters that
my daughter grew up with, such as Toy Story,
Monsters Inc. and Where The Wild Things
Are, a classic children's story | read to my
daughter at least once a week before bedtime.
These memories are precious and | love
incorporating them into my work.

When creating new worlds, do you

treat the characters differently?

Yes, but it depends on the character and the
property. My work with Disney years ago
instilled a deep respect for their properties
and characters, so | try to remain faithful to
the storylines and characters’ personalities.
However, | can get very irreverent with

other properties, like Star Wars. I've put
Stormtroopers in situations that are hilarious
and strange. Stormtroopers are often the butt
of the joke in many of my Star Wars images.

| also enjoy showing characters in unexpected
ways. For example, | recreated a famous scene
from the first Rocky movie with Sylvester
Stallone. In this scene, he's in a meat locker
with slabs of beef hanging from meat hooks.
As he angrily hits the slabs of beef, you can
hear the ribs of the beef cracking. But for my
image, instead of using beef, | used hot dogs
to create a fun and strange photograph - and
it was one that my audience loved.

What goes through your mind when
developing a little bit of a different story?
| try to come up with unexpected twists and
present characters in a unique manner. For
me, it's important to incorporate elements

of entertainment, joy, and humour. My Darth
Vader images are a great example of this. |
asked myself whether Darth Vader is a villain
24/7 or is that just his 9-to-5 job? What does
he do when he gets off work? Does he go
back to his cabin on the Death Star, kick off
his boots, take off his helmet and let down
his hair? Well, he doesn't really have any hair
because it was burned off in lava when he was
younger, but maybe he cracks open a beer
and watches some TV? That was my thought
process before creating an image where
Darth Vader is pushing a Stormtrooper on

a swing. | imagined it's the weekend and
they're out having a great time, without
thinking about villainous things.



Pictured
Downtime

Darth Vaderanda
Stormtrooper enjoy
some time out from
villainous thoughts

MITCHEL WU

Pictured
" Dog Pound
reating this scene, | had
‘the theme music on repeat.
It ended up on the cutting
‘room floor at the insistence
of the National Hot Dog
and Sausage Council”

You use elements such as fire and even
mini-explosions in your images. How do
you create these effects and do you prefer
real effects to adding them digitally?
Those are practical effects but you can create
many of the same effects digitally. Nowadays,
it can be difficult to differentiate between
what's real and what's digital. However, what

| enjoy most about toy photography is the
opportunity to play and | have a lot of fun
using fireworks in my photos. As a kid, | loved
playing with firecrackers, sparklers, and smoke
bombs. Blowing stuff up is fun, so having the
chance to do that for my work is pretty cool!
Apologies to my neighbours, who never

know when loud explosions might be heard
coming from my yard.

What are the most difficult types

of effects to incorporate on the set?

Liquid splashes are unpredictable. When
blasting water with a can of compressed air,
you don't really know what kind of splash
you're going to get. If you're lucky, you get
something dynamic on the first try, saving you
from continuous cleaning up and resetting —



.

Pictured -
Let The Wild
Rumpus Start
This scene, featuring
Max and the Wild
Things, shows how Wu
uses special effects to
enhance his stories

but that's rare, and it can often take dozens
of more tries before getting something you're
happy with. Despite all that, it's just fun to
create liquid splashes, whether it's with water,
coffee, beer or milk.

How do you decide which effect you
want to visualise with which figure?

| don't want to create effects gratuitously,
just because they're cool. | want them to
support and enhance the story being told.

If a Stormtrooper is just standing still and
suddenly a blast of dirt appears under his
feet, it doesn't really make sense. But if they
are jumping or being thrown back from an
explosion, an effect like that would absolutely
make sense. However, | try not to say there
is a right way and a wrong way to doing
anything, because people really just want to
do what they enjoy. And if that's creating
effects for no other reason than they enjoy
it, go for it and express yourself!

You have been featured in Marvel’s 616
series on Disney+. What was that like as
an experience, being part of the show?

It was an amazing experience, but it also

felt odd being in front of the camera. What
made it so interesting was that it gave me
the opportunity to share my experience with
a broad audience about finding a niche and
the impact it made on my career and life...

I'll elaborate more on this in a bit. Filming for
the documentary began at Toy Fair New York
in 2020, where | held the first exhibition in
Toy Fair's 100-plus-year history. The camera
team documented some of my experiences at
the event, which was really cool. We finished
filming at my house a week later. The little
cul-de-sac | live on was filled with film gear
trucks and my tiny backyard was packed with
the production crew and their gear. It was a
wonderful experience and I'm very grateful to
have had it. | was especially grateful to be able
to introduce toy photography to such a large
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Pictured
Calcium For
Strong Bones

For this shot, Wu used
1:18 scale skeletons
from Boss Fight Studio

audience, most of whom had never seen
or heard of toy photography before.

What is the first piece of advice you give
to someone starting in toy photography?
My advice to anyone, whether they're new or
a seasoned pro, is the same — find the story.
Tell me a story that makes me feel something.
Ultimately, this is what gives a photo impact
and makes it memorable. | would much
rather see an image that speaks to me on
some level, even if it's not technically amazing,
than see a technically perfect image that
says nothing to me. | do see the desire and
importance of perfecting one’s craft, but that
should be happening during your countless
hours of shooting and practicing, and not at
the expense of storytelling. That's part of the
journey. You need to shoot a lot to build up
your technical skills.

Pictured

Milk and Cookies
This image was used as
part of the promotional
campaign for Toy Story 4

Judging by the explosions in the
background, we’re guessing that you
shoot most of these scenes outdoors...
Yes, | definitely do that kind of shooting
outside. | won't be setting off fireworks inside
my studio, but | do shoot a lot indoors now.
Regardless of where | am, | always ensure
that | control the light. Especially if it's a client
project, everything has to be perfect. However,
| never forget about storytelling. While | still
deal with the available light, | also use artificial
lighting to make scenes more dynamic but

| try not to get too caught up with the setup.

So what artificial lighting do you use?

| mainly use small, battery-powered LED
lights that are charged up and ready to use.
Usually, | use them as fill lights. | sometimes
place them behind the characters to get a rim
light effect, which separates them from the




background and makes them pop. | also use
RGB lights to create specific colour moods.
Learning to use light is a skill I've learned later
on, it is an ongoing process. In the end, it all
comes back to telling the story and creating

a matching environment for the characters.

Can you tell us more about the career
niche aspect you mentioned earlier?
Ultimately the question is, in your photography
career, do you want to be a commodity or

do you want to be an asset? Do you want

to survive or do you want to thrive? You're

a commodity when you are competing for

jobs with hundreds, if not thousands, of other
photographers offering essentially the same
service at the same price. You are virtually
indistinguishable from your competitors. When
you're a commodity, you have little control

over your pricing and little negotiating strength.

This was me as a wedding photographer.

| photographed weddings for seven or eight
years, surviving but never really thriving. After
meeting a potential client, | knew they would
be likely to meet with two or three other
wedding photographers to see if they could
get a lower rate. Even if they really liked my
work, they'd often ask for a rate reduction.
That is working as a commodity.

Then, in 2015, | discovered toy photography
and was one of the first to pursue it as a
career. As | began getting more and more
work, | quickly saw the difference and benefit
of working in a niche and being an asset,
as opposed to being a commodity. Finding
a niche, or differentiating oneself from
the competition, is crucial for any artist or
photographer. You have infinitely more c<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>